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Safety warning notice

/\ WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not
place the device directly on your lap or obstruct the device air vents. Use the device only on a hard, flat
surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft surface,
such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact the
skin or a soft surface, such as pillows or rugs or clothing, during operation. The device and the AC
adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description Computer models Computer models
equipped with an equipped with an
AMD processor Intel processor
Product Name HP Pavilion dv7 Notebook PC J \/
Processors AMD® A8-3550MX 2.70-GHz processor (2.00- \/

GHz FSB, 4.0-MB L2 cache, quad core, 45 W)

AMD A8-3530MX 2.60-GHz processor (1.90- \/
GHz FSB, 4.0-MB L2 cache, quad core, 45 W)

AMD A8-3520M 2.50-GHz processor (1.60-GHz FSB, \/
4.0-MB L2 cache, quad core, 45 W)

AMD A8-3510MX 2.50-GHz processor (1.50- \/
GHz FSB, 4.0-MB L2 cache, quad core, 45 W)

AMD A8-3500M 2.40-GHz processor (1.50-GHz FSB, v
4.0-MB L2 cache, quad core, 35 W)

AMD A6-3430MX 2.40-GHz processor (1.70- \/
GHz FSB, 4.0-MB L2 cache, quad core, 45 W)

AMD A6-3420M 2.40-GHz processor (1.50-GHz FSB, J
4.0-MB L2 cache, quad core, 45 W)

AMD A6-3410MX 2.30-GHz processor (1.60- J
GHz FSB, 2.0-MB L2 cache, quad core, 45 W)

AMD A6-3400M 2.30-GHz processor (1.40-GHz FSB, N
4.0-MB L2 cache, quad core, 35 W)

AMD A4-3330MX 2.60-GHz processor (2.40- J
GHz FSB, 2.0-MB L2 cache, dual core, 45 W)

AMD A4-3320MX 2.60-GHz processor (2.00- J
GHz FSB, 2.0-MB L2 cache, dual core, 45 W)

AMD A4-3310MX 2.50-GHz processor (2.10- J
GHz FSB, 2.0-MB L2 cache, dual core, 45 W)

AMD A4-3305M 2.50-GHz processor (1.90-GHz FSB, \/
4.0-MB L2 cache, dual core, 45 W)

AMD A4-3300M 2.50-GHz processor (1.90-GHz FSB, \/
4.0-MB L2 cache, dual core, 35 W)




Category Description Computer models Computer models
equipped with an equipped with an
AMD processor Intel processor

AMD E2-3300M 2.50-GHz processor (1.90-GHz FSB, N
4.0-MB L2 cache, dual core, 35 W)

Intel® Core® i7-2860QM 2.50-GHz (SC turbo up to J
3.60-GHz) processor (1600-MHz FSB, 8.0-MB L3
cache, quad core, 45 W)

Intel Core i7-2820QM 2.30-GHz (SC turbo up to J
3.10-GHz) processor (1600-MHz FSB, 8.0-MB L3
cache, quad core, 45 W)

Intel Core i7-2760QM 2.40-GHz (SC turbo up to J
3.50-GHz) processor (1600-MHz FSB, 6.0-MB L3
cache, quad core, 45 W)

Intel Core i7-2720QM 2.20-GHz (SC turbo up to J
3.00-GHz) processor (1600-MHz FSB, 6.0-MB L3
cache, quad core, 45 W)

Intel Core i7-2670QM 2.20-GHz (SC turbo up to J
3.10-GHz) processor (1600-MHz FSB, 6.0-MB L3
cache, quad core, 45 W)

Intel Core i7-2640M 2.80-GHz (SC turbo up to 3.50- J
GHz) processor (1333-MHz FSB, 4.0-MB L3 cache,
dual core, 35 W)

Intel Core i7-2630QM 2.00-GHz (SC turbo up to J
2.90-GHz) processor (1600-MHz FSB, 6.0-MB L3
cache, quad core, 45 W)

Intel Core i7-2620M 2.70-GHz (SC turbo up to 3.40- J
GHz) processor (1333-MHz FSB, 4.0-MB L3 cache,
dual core, 35 W)

Intel Core i5-2540M 2.60-GHz (SC turbo up to 3.30- J
GHz) processor (1333-MHz FSB, 3.0-MB L3 cache,
dual core, 35 W)

Intel Core i5-2520M 2.50-GHz (SC turbo up to 3.20- J
GHz) processor (1333-MHz FSB, 3.0-MB L3 cache,
dual core, 35 W)

Intel Core i5-2450M 2.50-GHz processor (SC turbo up J
to 3.10-GHz), 3.0-MB L3 cache, 1333-MHz FSB,
dual core, 35 W)

Intel Core i5-2430M 2.40-GHz (SC turbo up to 3.00- J
GHz) processor (3.0-MB L3 cache, dual core, 35 W)

Intel Core i3-2370M 2.40-GHz processor (3.0-MB L3 J
cache, dual core, 35 W)

Intel Core i3-2350M 2.30-GHz processor (3.0-MB L3 J
cache, dual core, 35 W)

Intel Core i3-2330M 2.20-GHz processor (3.0-MB L3 J
cache, dual core, 35 W)
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Category

Description

Computer models Computer models
equipped with an equipped with an
AMD processor Intel processor

Intel Pentium B970 TJ85 2.30-GHz processor (2.0-MB
L3 cache, dual core, 35 W)

\/

Intel Pentium B960 TJ85 2.20-GHz processor (2.0-MB
L3 cache, dual core, 35 W)

Intel Pentium B950 TJ85 2.10-GHz processor (2.0-MB
L3 cache, dual core, 35 W)

Chipset

AMD A70M fusion controller hub (FCH)

Intel HM65 Express chipset

Graphics

Internal graphics:

e AMD Radeon™ HD 6620G graphics on
computer models equipped with an AMD
A8 processor

®  AMD Radeon HD 6520G graphics on computer
models equipped with an AMD Aé processor

®  AMD Radeon HD 6480G graphics on computer
models equipped with an AMD A4 processor

e  AMD Radeon HD 6380G graphics on computer
models equipped with an AMD E2 processor

Switchable discrete graphics:

e AMD Radeon HD 6755G2 graphics subsystem
on computer models equipped with an AMD A8
or A6 processor, with 1024-MB of dedicated
video memory (64-MB x 16 GDDR5 x 8 PCs, 3.2
GBPS), utilize VRAM component GDDR5 32-MB x
32 with 5GBPS capability

e AMD Radeon HD 6750M graphics subsystem on
computer models equipped with an AMD
A4 processor, with 1024-MB of dedicated video
memory (64-MB x 16 GDDR5 x 8 PCs, 3.2
GBPS), utilize VRAM component GDDR5 32-MB x
32 with 5GBPS capability




Category Description Computer models Computer models
equipped with an equipped with an

AMD processor Intel processor

Supports dual graphics: y
e AMD Radeon HD 6755G2 graphics subsystem

on computer models equipped with an AMD A8

or Ab processor
e AMD Radeon HD 6645G2 graphics subsystem

on computer models equipped with an AMD

A8 processor
e AMD Radeon HD 6545M graphics subsystem on

computer models equipped with an AMD

Ab processor
e AMD Radeon HD 6515G2 graphics subsystem

on computer models equipped with an AMD

A4 processor
Internal graphics: v
e Intel HD Graphics 3000 on computer models

equipped with an Intel Core i7, i5, or

i3 processor
e Intel HD Graphics on computer models equipped

with an Intel Pentium processor
Switchable discrete graphics: J
e ATIXT Radeon HD 6770M M2 package with

2048-MB (64-MB x 32 GDDR5 x 8 PCs, 5GBPS)

or 1024-MB (32-MB x 32 GDDR5 x 8 PCs,

5GBPS) of graphics subsystem discrete memory,

muxless
e ATi XT Radeon HD 6490M M2 package with

1024-MB of graphics subsystem discrete memory

(64-MB x 32 GDDR5 x 4 PCs, 5GBPS), muxless
Supports BACO, HD Decode, DX11, and HDMI (only y J
on computer models equipped with a graphics
subsystem with discrete memory)

Panel 17.3-in, full high-definition (FHD), light-emitting diode J

(LED), WVA AntiGlare (1920x1080) display; typical
brightness: 300 nits
17.3-in, high-definition+ (HD+), LED, SVA BrightView N v
(1600x900) display; typical brightness: 200 nits
All display assemblies include 2 wireless local area \/ 3
network (WLAN) antenna cables
Supports 16:9 ultra wide aspect ratio y J
Supports low-voltage differential signalling (LVDS) \/ J
Lighted logo on top bezel \/ \/
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Category Description Computer models Computer models
equipped with an equipped with an
AMD processor Intel processor
Memory 2 customer-accessible/upgradable J y
memory module slots
Supports dual-channel memory J y
Supports up to 8192 GB of system RAM R
Supports up to 16384 GB of system RAM V
DDR3/1333-MHz J y
Supports the following configurations: J
e 8192-MB total system memory (8192x1 or
4096x2)
e 6144-MB total system memory (4096x1 +
2048x1)
e 4096-MB total system memory (4096x1 or
2048x2)
e 2048-MB total system memory (2048x1)
Supports the following configurations: \/
e 16384-MB total system memory (8192x2)
e  12288-MB total system memory (8192x1 +
4096x1)
e 8192-MB total system memory (8192x1 or
4096x2)
e  6144-MB total system memory (4096x1 +
2048x1)
e 4096-MB total system memory (4096x1 or
2048x2)
e 2048-MB total system memory (2048x1)
Hard drives Supports 6.35-ecm (2.5-in) hard drives in 12.7-mm (. R v
50-in), 9.5-mm (.37-in), and 7.0-mm (.28-in)
thicknesses
Customer-accessible J 3
Accelerometer hard drive protection support J y
Supports up to 2 hard drives N \/
Supports 160-GB solid-state drive (solid-state drive) \/
Serial ATA J 3
Supports 500-GB, 7200-rpm, 9.5-mm hard drive + y

160-GB solid-state drive combination
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Category

Description

Computer models
equipped with an
AMD processor

Computer models
equipped with an
Intel processor

Supports the following double hard drive y J
configurations:
e 2TB:(1TB, 5400 rpm, 12.5 mm x 2)
e 1500 GB: (750 GB, 7200 rpm, 9.5 mm x 2)
e 1500 GB: (750 GB, 5400 rpm, 9.5 mm x 2)
e 1 TB: (500 GB, 5400 rpm, 9.5 mm x 2)
Optical drive Fixed y \/
Serial ATA N N
12.7-mm tray load y J
Supports Blu-ray Disc ROM FX SuperMulti DVD+R/RW J
Double-Layer Drive
Supports Blu-ray Disc R/RW FX SuperMulti Drive \/ 3
Supports DVD+RW Double-Layer FX SuperMulti Drive J
Avudio and video  Dual array digital microphones with appropriate V J
beamforming, echo-cancellation, noise-suppression
software
HD audio V \/
HP-branded Altec/Lansing quad Beats Audio speakers y J
(select models only)
HP TrueVision HD webcamera (fixed, integrated, N N
lowlight)
Ethernet Integrated 10/100/1000 network interface card (NIC) N \
Wireless Integrated wireless local area network (WLAN) options N v
by way of wireless module
Two WLAN antennas built into display assembly 3 \/
Support for the following WLAN formats: y J

®  Ralink 5390GN 802.11b/g/n 1x1
WiFi Adapter

®  Realtek 8188GN 802.11b/g/n 1x1
WiFi Adapter
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Category

Description

Support for the following WLAN formats:

Atheros 9485GN 802.11b/g/n 1x1 WiFi and
3012 Bluetooth 4.0 Combo Adapter

Atheros AR9002WB-TNGB 802.11b/g/n 1x1
WiFi and Bluetooth 2. 1TEDR+ Combo Adapter
(BT3.0+HS ready)

Broadcom 4313 802.11b/g/n 1x1 WiFi and
2070 Bluetooth 2.1+EDR Combo adapter
(BT3.0+HS ready)

Broadcom 4313GN 802.11b/g/n 1x1 WiFi
and 20702 Bluetooth 4.0 Combo Adapter

Support for the following WLAN formats:

Broadcom 4313 802.11b/g/n 1x1
WiFi Adapter

Intel Centrino Advanced-N 6230 WLAN module

Intel Centrino Wireless-N + WiMAX 6150
WILAN module

Intel Centrino Wireless-N 1000 802.11b/g/n
1x2 WLAN module

Ralink RT3090BC4 802.11b/g/n 1x1 WiFi and
Bluetooth 2.1+EDR Combo adapter
(BT3.0+HS ready)

External media
card

Digital Media Slot supports the following digital
card formats:

MultiMediaCard
Secure Digital (SD) Memory Card
Secure Digital High Capacity Memory card

Secure Digital Extended Capacity Memory Card

HP Multi-Format digital Media Reader support SD/
SDHC/SDXC with UHS104 support, MMC push-push

insertion and removal

Computer models
equipped with an
AMD processor

Computer models
equipped with an
Intel processor



Category Description Computer models Computer models
equipped with an equipped with an
AMD processor Intel processor

Ports e 3-pin AC power y J
e Audio-in (mono microphone)
e Audio-out (stereo headphone)

e HDMI version 1.4 supporting 1920x1200
@ 60Hz

e RJ-45 (Ethernet, includes link and activity lights)
e USB 2.0 (3 ports)

e On computer models equipped with an
AMD processor: VGA (Dsub 15 pin) supporting
2048x1536 external resolution @ 85 Hz,
1920x 1600 external resolution @ 60Hz, hot plug
and unplug and auto-detection for correct output
to wide-aspect vs. standard aspect video

e On computer models equipped with an
Intel processor: VGA (Dsub 15 pin) supporting
2048x1536 external resolution @ 75 Hz,
1920%1200 external resolution @ 60Hz, hot plug
and unplug and auto-detection for correct output
to wide-aspect vs. standard aspect video

Keyboard/ Fullsize, Dura-coat, island-style keyboard with full \/ 3
pointing devices  numeric keypad

TouchPad with multitouch gestures, 2-finger scrolling, \/ J
and pinch-zoom enabled

Taps enabled by default y J

Power 90W slim travel AC adapter with localized cable plug \/ \/
requirements support (3-wire plug with ground pin, supports 3-pin
DC connector)

65W slim travel AC adapter with localized cable plug
support (3-wire plug with ground pin, supports 3-pin
DC connector)

120W slim travel AC adapter with localized cable J
plug support (3-wire plug with ground pin, supports 3-
pin DC connector)

Support for the following batteries: y J
e 9cell, 3.00-Ah (100-Wh) Li-ion battery

e 6cell, 2.80-Ah (62-Wh) Li-ion battery

e 6cell, 2.55-Ah (55-Wh) Li-ion battery

Supports fast charge
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Category

Description

Computer models Computer models
equipped with an equipped with an
AMD processor Intel processor

Security

Security cable slot

Fingerprint reader with Digital Persona
software support

v v

Supporis Intel AT-p Ready

Operating
system

Preinstalled:
®  Windows 7 Home Premium (64- and 32-bit)

®  Windows 7 Home Premium (64- and 32-bit)

Preinstalled:

®  Windows 7 Home Basic (64- and 32-bit)

e Windows 7 Home Premium (64- and 32-bit)
®  Windows 7 Professional (64- and 32-bit)

e Windows 7 Starter (64- and 32-bit)

e Windows 7 Ultimate (64-bit)

e  RedFlag

e  FreeDOS

Serviceability

End-user replaceable parts:
e AC adapter

e  Battery

e Hard drives (2)

e Memory modules (2)

e  Optical drive

e WILAN module
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Top

Buttons

Item

Component

Description

m

Power button

®  When the computer is off, press the button to turn on
the computer.

e When the computer is on, press the button briefly to
initiate Sleep.

®  When the computer is in the Sleep state, press the
button briefly to exit Sleep.

®  When the computer is in Hibernation, press the
button briefly to exit Hibernation.

If the computer has stopped responding and Windows
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off

the computer.

To learn more about your power settings, select Start >
Control Panel > System and Security > Power
Options, or refer to the HP Notebook Reference Guide.

Top
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Item

Component

Description

2)

Web browser

Opens a Web browser.

NOTE: Until you set up your Internet or network
services, this button opens the Internet
Connection Wizard.

3)

Fingerprint reader (select models only)

Allows a fingerprint logon to Windows instead of a
password logon.

Keys

Item Component Description

(1) esc key Displays system information when pressed in combination
with the fn key.

(2) fn key Executes frequently used system functions when pressed
in combination with the b key, the esc key, or the num
lk key.

(3) Windows logo key Displays the Windows Start menu.

12 Chapter 2 External component identification



Item

Component

Description

(4)

b key

Increases or decreases the Beats Audio bass settings.

Beats Audio is an enhanced audio profile that provides a
deep, controlled bass while maintaining a clear sound.
Beats Audio is enabled by default.

You can also view and control the bass settings through
the Windows operating system. To view and control the
bass properties:

e  Select Start > Programs > Beats Audio
Control Panel > Listening Experience.

—or —

e  Select Start > Control Panel > Hardware
and Sound > Beats Audio Control Panel >
Listening Experience.

(5)

Windows applications key

Displays a shortcut menu for items beneath the pointer.

(6)

Integrated numeric keypad

When the keypad has been enabled, the keys can be
used like an external numeric keypad.

)

num |k key

Enables/disables the integrated numeric keypad when
pressed in combination with the fn key.

(®)

Action keys

Execute frequently used system functions.

Top
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Lights

&
Item Component Description
(1) Caps lock light ®  White: Caps lock is on.
e Off: Caps lock is off.
(2) Power light ®  White: The computer is on.
e Blinking white: The computer is in the Sleep state.
e Off: The computer is off or in Hibernation.
(3) Mute light e White: Computer sound is on.
e Amber: Computer sound is off.
(4) Wireless light e White: An integrated wireless device, such as a
wireless local area network (WLAN) device and/or
a Bluetooth device, is on.
e Amber: All wireless devices are off.
(5) TouchPad on light e On: The TouchPad is on.
e Off: The TouchPad is off.
(6) TouchPad off light e Off: The TouchPad is on.
e On: The TouchPad is off.
(7) Fingerprint reader light (select models only) ®  White: The fingerprint was read.
e Amber: The fingerprint was not read.
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TouchPad

]

Item

Component

Description

m

TouchPad off light

o  Off: The TouchPad is on.
®  On: The TouchPad is off.

NOTE: Press fn+space to turn off the TouchPad light.

(2)

TouchPad icon

Turns the TouchPad on and off. Quickly double-tap the
TouchPad icon to turn the TouchPad on and off.

(3)

TouchPad zone

Moves the pointer and selects or activates items on
the screen.

(4)

Left TouchPad button

Functions like the left button on an external mouse.

(5)

TouchPad on light

e On: The TouchPad is on.
o Off: The TouchPad is off.

NOTE: Press fn+space to turn off the TouchPad light.

(6)

Right TouchPad button

Functions like the right button on an external mouse.

Top
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Display

16

Item Component Description

(1) WILAN antennas (2)* Send and receive wireless signals to communicate with
wireless local area networks (WLAN).

(2) Internal microphones (2) Record sound.

(3) Webcam light On: The webcam is in use.

(4) Webcam Records video and captures still photographs. To use the

webcam, select Start > All Programs > CyberLink
YouCam > CyberLink YouCam.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around
the antennas free from obstructions. To see wireless regulatory notices, refer to the section of the Regulatory, Safety, and
Environmental Notices that applies to your country or region. These notices are located in Help and Support.

Chapter 2 External component identification



Front

ltem Component Description
(1) Speakers (2) Produce sound.
(2) Digital Media Slot Supports the following digital card formats:

o  MultiMediaCard

e Secure Digital (SD) Card

Front
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Left side
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Item Component

Description

(1) Vent

Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
infernal components and prevent overheating. It is normal
for the internal fan to cycle on and off during

routine operation.

(2) External monitor port

Connects an external VGA monitor or projector.

(3) HDMI port

Connects an optional video or audio device, such as a
high-definition television, or any compatible digital or
audio component.

4) R)-45 (network) jack

Connects a network cable.

(5) SuperSpeed USB ports (2)

Connect optional USB 3.0 devices and provide
enhanced USB power performance.

NOTE: The SuperSpeed USB ports are also compatible
with USB 1.0 and 2.0 devices.

(6) Audio-in (microphone) jack

Connects an optional computer headset microphone,
stereo array microphone, or monaural microphone.

(7) Audio-out (headphone) jacks (2)

Produce sound when connected to optional powered
stereo speakers, headphones, ear buds, a headset, or
television audio.

WARNING! To reduce the risk of personal injury,
adjust the volume before putting on headphones,
earbuds, or a headset. For additional safety information,
refer to the Regulatory, Safety, and

Environmental Notices.

NOTE: When a device is connected to a jack,
the computer speakers are disabled.
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ltem Component Description

— ¥

(1) Power light e White: The computer is on.
e  Blinking white: The computer is in the Sleep state.

e Off: The computer is off or in Hibernation.

(2) Drive light e  Blinking white: The hard drive is being accessed.

®  Amber: HP ProtectSmart Hard Drive Protection has
temporarily parked the hard drive.

NOTE: For information on HP ProtectSmart Hard
Drive Protection, refer to the HP Notebook
Reference Guide.

(3) USB ports (2) Connect optional USB devices.
(4) Optical drive Reads and writes to an optical disc.
(5) Optical drive light e White: The optical drive is being accessed.

e Amber: The optical drive is off.

(6) Optical drive eject button Ejects the optical disc.

(7) AC adapter light ®  White: The computer is connected to external power
and the battery is fully charged.

e Amber: The battery is charging.

e Off: The computer is not connected to
external power.

(8) Power connector Connects an AC adapter.

9) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deferrent, but it may not prevent the computer from being
mishandled or stolen.
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Item Component Description
(1) Integrated subwoofer Provides superior bass sound.
(2) Vents (7) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
infernal components and prevent overheating. It is normal
for the internal fan to cycle on and off during

routine operation.

(3) Battery bay Holds the battery.

(4) Battery release latch Releases the battery from the battery bay, and releases
the hard drive/memory module compartment cover.

(5) Hard drive bay Holds the hard drive and wireless LAN (WLAN) device,
and contains the memory module slots.

CAUTION: To prevent an unresponsive system, replace
the wireless module only with a wireless module
authorized for use in the computer by the governmental
agency that regulates wireless devices in your country or
region. If you replace the module and then receive a
warning message, remove the module to restore
computer functionality, and then contact technical support
through Help and Support.
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Service tag

When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag. [When ordering parts or requesting information, provide
the computer serial number and model description provided on the service tag.]

?

® |

Serial= XX0CCO0OC  INNTN VMR WA AIMSINRW

—Product: X000 |IINMMEMNINNNNIN

__Warranty: 1ylyOy
| Model: XX0000X

Item

Description

Function

m

Product name:

This is the product name affixed to the front of
the computer.

(2)

Serial number (s/n):

This is an alphanumeric identifier that is unique to
each product.

3)

Part number/Product number (p/n):

This number provides specific information about the
product's hardware components. The part number
helps a service technician to defermine what
components and parts are needed.

4

Warranty period:

This number describes the duration of the warranty
period for the computer.

(5)

Model description:

This is the alphanumeric identifier needed to locate
documents, drivers, and support for the computer.
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Item Component

Spare part number

(1) Display assembly: The display assembly is spared at the subcomponent level only. For more display assembly

spare part information, see Display assembly subcomponents on page 30.

(2) Keyboard (includes keyboard cable):

For use with all computer models:

For use in Belgium 666001-A41
For use in Canada 666001-121
For use in the Czech Republic and Slovakia 666001-FL1
For use in Denmark, Finland, and Norway 666001-DH1
For use in France 666001-051
For use in Germany 666001-041
For use in Greece 666001-DJ1
For use in Hungary 666001-211
For use in ltaly 666001-061
For use in the Netherlands 666001-B31
For use in Portugal 666001-131
For use in Russia 666001-251
For use in Slovenia 666001-BA1
For use in Spain 666001-071
For use in Switzerland 666001-BG1
For use in Turkey 666001-141
For use in the United Kingdom and Singapore 666001-031
For use in the United States 666001-001
For use only with computer models equipped with an Intel processor:
For use in India 666001-D61
For use in Israel 666001-BB1
For use in Japan 666001-291
For use in Saudi Arabia 666001-171
For use in South Korea 666001-AD1
For use in Taiwan 666001-AB1
For use in Thailand 666001-281
(3) Top cover (includes TouchPad and TouchPad cable and TouchPad button board and TouchPad button
board cable):
In dark umber finish 665998-001
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Item Component Spare part number
In steel gray finish 665999001
(4) Display lid switch board (includes cable) 665603-001
(5) Power button board (does not include cable) 665600-001
(6) Fingerprint reader board (includes bracket, but does not include cable) 665310001
(7) SD Card reader board (does not include cable) 665602-001
(8) USB board (does not include cable) 665331-001
Speaker Kit, includes: 665610-001
(9a) Front speakers (includes front left and right speakers and cables)
(9b) Rear speakers (includes rear left and right speakers, grill, and cable)
(10) Bluetooth module (EDR v.3.0, for use only with computer models equipped with an 537921-001
Intel processor, does not include cable)
(11) Bluetooth module cable (for use only with computer models equipped with an 665595-001
Intel processor)
(12) Power connector cable 665596-001
(13) System board (includes replacement thermal material):
For use only with computer models equipped with an AMD processor and a graphics 666520-001
subsystem with discrete memory
For use only with computer models equipped with an AMD processor and a graphics 666518-001
subsystem with UMA memory
For use only with computer models equipped with the Intel 6770 chipset, a 665991-001
quad core processor, and a graphics subsystem with 2048-MB of discrete memory
For use only with computer models equipped with the Intel 6770 chipset, a 665992001
dual core processor, and a graphics subsystem with 2048-MB of discrete memory
For use only with computer models equipped with the Intel 6770 chipset, a 665988-001
quad core processor, and a graphics subsystem with 1024-MB of discrete memory
For use only with computer models equipped with the Intel 6770 chipset, a 665989-001
dual core processor, and a graphics subsystem with 1024-MB of discrete memory
For use only with computer models equipped with the Intel 6490 chipset, a 665986-001
quad core processor, and a graphics subsystem with 1024-MB of discrete memory
For use only with computer models equipped with the Intel 6490 chipset, a 665987001
dual core processor, and a graphics subsystem with 1024-MB of discrete memory
For use only with computer models equipped with the Intel HM65 chipset, a 665993-001
quad core processor, and a graphics subsystem with UMA memory
For use only with computer models equipped with the Intel HM65 chipset, a 665990001
dual core processor, and a graphics subsystem with UMA memory
Thermal Material Kit (includes replacement thermal pads and paste):
For use only with computer models equipped with an AMD processor and a graphics 665286-001

subsystem with discrete memory

Computer major components
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ltem Component Spare part number
For use only with computer models equipped with an AMD processor and a graphics 665285001
subsystem with UMA memory
For use only with computer models equipped with an Intel processor and a graphics 665355001
subsystem with 2048-MB of discrete memory
For use only with computer models equipped with an Intel processor and a graphics 665354001
subsystem with 1024-MB of discrete memory
For use only with computer models equipped with an Intel processor and a graphics 665353-001
subsystem with UMA memory

(14) Processor (includes replacement thermal material)
AMD A8-3550MX 2.70-GHz processor (2.00-GHz FSB, 4.0-MB L2 cache, quad core, 669691-001
45 W)
AMD A8-3530MX 2.60-GHz processor (1.90-GHz FSB, 4.0-MB L2 cache, quad core, 653364-001
45 W)
AMD A8-3520M 2.50-GHz processor (1.60-GHz FSB, 4.0-MB L2 cache, quad core, 669690-001
45 W)
AMD A8-3510MX 2.50-GHz processor (1.50-GHz FSB, 4.0-MB L2 cache, quad core, 653358-001
45 W)
AMD A8-3500M 2.40-GHz processor (1.50-GHz FSB, 4.0-MB L2 cache, quad core, 653350-001
35 W)
AMD A6-3430MX 2.40-GHz processor (1.70-GHz FSB, 4.0-MB L2 cache, quad core, 669689-001
45 W)
AMD A6-3420M 2.40-GHz processor (1.50-GHz FSB, 4.0-MB L2 cache, quad core, 669688-001
45 W)
AMD A6-34T10MX 2.30-GHz processor (1.60-GHz FSB, 2.0-MB L2 cache, quad core, 653357-001
45 W)
AMD A6-3400M 2.30-GHz processor (1.40-GHz FSB, 4.0-MB L2 cache, quad core, 653349-001
35W)
AMD A4-3330MX 2.60-GHz processor (2.40-GHz FSB, 2.0-MB L2 cache, dual core, 669687-001
45 W)
AMD A4-3320MX 2.60-GHz processor (2.00-GHz FSB, 2.0-MB L2 cache, dual core, 669686-001
45 W)
AMD A4-3310MX 2.50-GHz processor (2.10-GHz FSB, 2.0-MB L2 cache, dual core, 653356-001
45 W)
AMD A4-3305M 2.50-GHz processor (1.90-GHz FSB, 4.0-MB L2 cache, dual core, 672093-001
45 W)
AMD A4-3300M 2.50-GHz processor (1.90-GHz FSB, 4.0-MB L2 cache, dual core, 653348-001
35 W)
AMD E2-3300M 2.50-GHz processor (1.90-GHz FSB, 4.0-MB L2 cache, dual core, 653351-001
35 W)
Intel Core i7-2860QM 2.50-GHz (SC turbo up to 3.60-GHz) processor (1600-MHz FSB,  666175-001

8.0-MB L3 cache, quad core, 45 W)
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Item Component Spare part number
Intel Core i7-2820QM 2.30-GHz (SC turbo up to 3.10-GHz) processor (1600-MHz FSB,  634694-001
8.0-MB L3 cache, quad core, 45 W)

Intel Core i7-2760QM 2.40-GHz (SC turbo up to 3.50-GHz) processor (1600-MHz FSB,  666174-001
6.0-MB L3 cache, quad core, 45 W)

Intel Core i7-2720QM 2.20-GHz (SC turbo up to 3.00-GHz) processor (1600-MHz FSB,  631254-001
6.0-MB L3 cache, quad core, 45 W)

Intel Core i7-2670QM 2.20-GHz (SC turbo up to 3.10-GHz) processor (1600-MHz FSB,  665116-001
6.0-MB L3 cache, quad core, 45 W)

Intel Core i7-2640M 2.80-GHz (SC turbo up to 3.50-GHz) processor (1333-MHz FSB, 666173-001
4.0-MB L3 cache, dual core, 35 W)

Intel Core i7-2630QM 2.00-GHz (SC turbo up to 2.90-GHz) processor (1600-MHz FSB,  635501-001
6.0-MB L3 cache, quad core, 45 W)

Intel Core i7-2620M 2.70-GHz (SC turbo up to 3.40-GHz) processor (1333-MHz FSB, 631252-001
4.0-MB L3 cache, dual core, 35 W)

Intel Core i5-2540M 2.60-GHz (SC turbo up to 3.30-GHz) processor (1333-MHz FSB, 631255-001
3.0-MB L3 cache, dual core, 35 W)

Intel Core i5-2520M 2.50-GHz (SC turbo up to 3.20-GHz) processor (1333-MHz FSB, 631253-001
3.0-MB L3 cache, dual core, 35 W)

Intel Core i5-2450M 2.50-GHz processor (SC turbo up to 3.10-GHz), 3.0-MB L3 cache,  676359-001
1333-MHz FSB, dual core, 35 W)

Intel Core i5-2430M 2.40-GHz (SC turbo up to 3.00-GHz) processor (3.0-MB L3 cache, = 653341-001
dual core, 35 W)

Intel Core i3-2370M 2.40-GHz processor (3.0-MB L3 cache, dual core, 35 W) 677152001
Intel Core i3-2350M 2.30-GHz processor (3.0-MB L3 cache, dual core, 35 W) 653340-001
Intel Core i3-2330M 2.20-GHz processor (3.0-MB L3 cache, dual core, 35 W) 653339-001
Intel Pentium B970 TJ85 2.30-GHz processor (2.0-MB L3 cache, dual core, 35 W) 676785-001
Intel Pentium B960 TJ85 2.20-GHz processor (2.0-MB L3 cache, dual core, 35 W) 664662-001
Intel Pentium B950 TJ85 2.10-GHz processor (2.0-MB L3 cache, dual core, 35 W) 653338-001

(15) Fan/heat sink assembly (includes replacement thermal material):

For use only with computer models equipped with an AMD processor and a graphics 666527001
subsystem with discrete memory

For use only with computer models equipped with an AMD processor and a graphics 666526001
subsystem with UMA memory

For use only with computer models equipped with an Intel processor and a graphics 666391001
subsystem with 2048-MB of discrete memory

For use only with computer models equipped with an Intel processor and a graphics 666390-001
subsystem with 1024-MB of discrete memory

For use only with computer models equipped with an Intel processor and a graphics 666392-001

subsystem with UMA memory
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ltem Component Spare part number
(16) Subwoofer (includes isolators and cable) 665611-001
(17) Base enclosure (includes battery release latch and 4 rubber feet) 665978-001
(18) Hard drive (2, 2.5-in, SATA, does not include bracket, connector cable, Mylar shield, or screws):
1-TB, 5400-rpm, 12.7-mm 638974-001
750-GB, 7200-rpm, 9.5-mm 633252-001
750-GB, 5400-rpm, 9.5-mm 634250-001
640-GB, 5400-rpm, 9.5-mm 603785-001
500-GB, 7200-rpm, 9.5-mm 608218-001
500-GB, 5400-rpm, 9.5-mm 634932-001
320-GB, 7200-rpm, 9.5-mm 634862-001
320-GB, 5400-rpm, 9.5-mm 622643-001
Hard Drive Hardware Kit (not illustrated, includes bracket, connector cable, Mylar 665597-001
shield, and screws)
160-GB solid-state drive (not illustrated, does not include bracket, connector cable, Mylar shield, or screws):
For use only with computer models equipped with an AMD processor 682679-001
For use only with computer models equipped with an Intel processor 665985-001
(19) Optical drive (includes bezel, bracket, cable, and screws):
Blu-ray Disc ROM FX SuperMulti DVD+R/RW Double-Layer Drive 666394-001
Blu-ray Disc R/RW FX SuperMulti Drive 666393-001
DVD+RW Double-Layer FX SuperMulti Drive (for use only with computer models equipped  666395-001
with an Intel processor)
(20) Battery
9-cell, 100-WHFr, 3.00-AHr, LI 636631-001
6-cell, 62-WHr, 2.80-AHr, LI 593562-001
6-cell, 55-WHr, 2.55-AHr, LI 593554-001
(21) RTC battery (includes cable and double-sided tape) 665606001
(22) Memory modules (2)

For use with all computer models:

4-GB memory module (DDR3, 10600, 1333-MHz) 621569-001

2-GB memory module (DDR3, 10600, 1333-MHz) 621565-001

For use only with computer models equipped with an AMD processor:

4-GB memory module (DDR3, 12800, 1600-MHz) 641369-001

8-GB memory module for use only with computer models equipped with an Intel processor 634091-001
(DDR3, 10600, 1333-MHz)
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Item Component Spare part number

(23) WLAN module:
For use with all computer models:
Ralink 5390GN 802.11b/g/n 1x1 WiFi Adapter 630703-001
Realtek 8188GN 802.11b/g/n 1x1 WiFi Adapter 640926-001
For use only with computer models equipped with an AMD processor:
Atheros 9485GN 802.11b/g/n 1x1 WiFi and 3012 Bluetooth 4.0 Combo Adapter 655795-001
Atheros ARP002WB-TNGB 802.11b/g/n 1x1 WiFi and Bluetooth 2.1EDR+ Combo 593127-001
Adapter (BT3.0+HS ready)
Broadcom 4313 802.11b/g/n 1x1 WiFi and 2070 Bluetooth 2.1+EDR Combo adapter  600370-001
(BT3.0+HS ready)
Broadcom 4313GN 802.11b/g/n 1x1 WiFi and 20702 Bluetooth 4.0 Combo Adapter  657325-001
For use only with computer models equipped with an Intel processor:
Broadcom 4313 802.11b/g/n 1x1 WiFi Adapter 593836-001
Intel Centrino Advanced-N 6230 WLAN module 631956001
Intel Centrino Wireless-N + WiMAX 6150 WLAN module 633817-001
Intel Centrino WirelesssN 1000 802.11b/g/n 1x2 WLAN module 593530-001
Ralink RT3090BC4 802.11b/g/n 1x1 WiFi and Bluetooth 2.1+EDR Combo adapter 630705-001
(BT3.0+HS ready)

(24) Service cover — available in the Plastics Kit, spare part number 665604-001)
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ltem Component Spare part number
(1) Display bezel 665592001
(2) Display Hinge Kit (includes left and right display hinges and brackets) 665599-001
(3) Display panel:
17.3-in, FHD, LED, AntiGlare display panel for use only with computer models equipped ~ 666397-001
with an Intel processor
17.3-in, HD+, LED, BrightView display panel for use with all computer models 666396-001
(4) Display Cable Kit (includes display panel cable and webcamera/ 665594-001
microphone module cable)
(5) Webcamera/microphone module 665365-001
(6) Antenna Kit (includes left and right wireless antenna cables and transceivers) 665591-001
(7) Display enclosure:
In dark umber finish 665976001
In steel gray finish 665977001
Display Rubber Kit (not illustrated, include Mylar screw covers) 665607-001
Display Screw Kit (not illustrated) 665609001

Chapter 3 lllustrated parts catalog



Mass storage devices
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Item Component Spare part number

(1) Hard drive (2.5-in, SATA, does not include bracket, connector cable, Mylar shield, or screws):
1-TB, 5400-rpm, 12.7-mm 638974-001
750-GB, 7200-rpm, 9.5-mm 633252001
750-GB, 5400-rpm, 9.5-mm 634250-001
640-GB, 5400-rpm, 9.5-mm 603785-001
500-GB, 7200-rpm, 9.5-mm 608218-001
500-GB, 5400-rpm, 9.5-mm 634932001
320-GB, 7200-rpm, 9.5-mm 634862-001
320-GB, 5400-rpm, 9.5-mm 622643-001
Hard Drive Hardware Kit, includes: 665597-001

(2a) Primary hard drive connector cable

(2b) Primary hard drive bracket

(4a) Secondary hard drive connector cable

(4b) Secondary hard drive bracket

Screws (not illustrated)

(3) 160-GB solid-state drive (does not include bracket, connector cable, Mylar shield, or screws):
For use only on computer models equipped with an AMD processor 682679-001
For use only on computer models equipped with an Intel processor 665985-001
(5) Optical drive (includes bezel, bracket, cable, and screws):
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ltem Component Spare part number

Blu-ray Disc ROM FX SuperMulti DVD+R/RW Double-Layer Drive 666394001

Blu-ray Disc R/RW FX SuperMulti Drive 666393-001

DVD+RW Double-Layer FX SuperMulti Drive (for use only with computer models equipped  666395-001
with an Intel processor)

Miscellaneous parts

Component Spare part number

HP Smart AC adapter

120-W, PFC, RC, V HP Smart AC adapter for use with all computer models 609941-001
90-W, PFC, RC, V HP Smart AC adapter for use with all computer models 609940-001
65-W RC, V HP Smart AC adapter for use with all computer models 609939001

90-W, PFC, RC, V, EM HP Smart AC adapter for use only with computer models equipped with an 609947-001
Intel processor

65-W, PFC, RC, V, EM HP Smart AC adapter for use only with computer models equipped with an 609948-001
Intel processor

Power cord (3-pin, black, 1.83-meter):

For use with all computer models:

For use in Denmark 490371-081
For use in Europe 490371-021
For use in Italy 490371061
For use in North America 490371-001
For use in South Africa 490371-AR1
For use in Switzerland 490371-111
For use in the United Kingdom and Singapore 490371-031

For use only with computer models equipped with an Intel processor:

For use in Australia 490371011
For use in India 490371-D61
For use in Israel 490371-BB1
For use in Japan 490371-291
For use in South Korea 490371-AD1
For use in Taiwan 490371-AB1
For use in Thailand 490371-201
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Component Spare part number

Remote control (fullfunction with teletext) 465541-004
Screw Kit 665608-001
USB DVB-T dipole antenna 581223-001
USB DVB-T TV tuner 581222-001

Sequential part number listing

Spare part number  Description

465541004 Remote control (full-function with teletext)
490371001 Power cord for use with all computer models in North America (3-pin, black, 1.83-meter)
490371011 Power cord for use only with computer models equipped with an Intel processor in Australia (3-pin,

black, 1.83-meter)

490371021 Power cord for use with all computer models in Europe (3-pin, black, 1.83-meter)

490371031 Power cord for use with all computer models in the United Kingdom and Singapore (3-pin, black,
1.83-meter)

490371061 Power cord for use with all computer models in ltaly (3-pin, black, 1.83-meter)

490371081 Power cord for use with all computer models in Denmark (3-pin, black, 1.83-meter)

490371-111 Power cord for use with all computer models in Switzerland (3-pin, black, 1.83-meter)

490371-201 Power cord for use only with computer models equipped with an Intel processor in Brazil (3-pin,

black, 1.83-meter)

490371-291 Power cord for use only with computer models equipped with an Intel processor in Japan (3-pin,

black, 1.83-meter)

490371-AB1 Power cord for use only with computer models equipped with an Intel processor in Taiwan (3-pin,

black, 1.83-meter)

490371-AD1 Power cord for use only with computer models equipped with an Intel processor in South Korea (3-
pin, black, 1.83-meter)

490371-AR1 Power cord for use with all computer models in South Africa (3-pin, black, 1.83-mefer)

490371-BB1 Power cord for use only with computer models equipped with an Intel processor in Israel (3-pin,
black, 1.83-meter)

490371-D61 Power cord for use only with computer models equipped with an Intel processor in India (3-pin,
black, 1.83-meter)

537921001 Bluetooth module (EDR v.3.0, for use only with computer models equipped with an Intel processor,
does not include cable)

581222-001 USB DVB-T TV tuner

581223-001 USB DVB-T dipole antenna
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Spare part number

Description

593127-001 Atheros AR9002WB-TNGB 802.11b/g/n 1x1 WiFi and Bluetooth 2.1EDR+ Combo Adapter
(BT3.0+HS ready) for use only with computer models equipped with an AMD processor

593530-001 Intel Centrino Wireless-N 1000 802.11b/g/n 1x2 WLAN module for use only with computer
models equipped with an Intel processor

593554-001 6-cell, 55-WHr, 2.55-AHr, Li battery

593562-001 6-cell, 62-WHr, 2.80-AHr, Li battery

593836001 Broadcom 4313 802.11b/g/n 1x1 WiFi Adapter for use only with computer models equipped
with an Intel processor

600370-001 Broadcom 4313 802.11b/g/n 1x1 WiFi and 2070 Bluetooth 2.1+EDR Combo adapter
(BT3.0+HS ready) for use only with computer models equipped with an AMD processor

603785-001 640-GB, 5400-rpm hard drive (2.5-in, SATA, does not include bracket, connector cable, Mylar
shield, or screws)

608218001 500-GB, 7200-rpm hard drive for use only with computer models equipped with an Intel processor
(2.5-in, SATA, does not include bracket, connector cable, Mylar shield, or screws)

609939001 65-W RC, V HP Smart AC adapter for use with all computer models

609940-001 90-W, PFC, RC, V HP Smart AC adapter for use with all computer models

609941-001 120-W, PFC, RC, V HP Smart AC adapter for use with all computer models

609947001 90-W, PFC, RC, V, EM HP Smart AC adapter for use only with computer models equipped with an
Intel processor

609948001 65-W, PFC, RC, V, EM HP Smart AC adapter for use only with computer models equipped with an
Intel processor

621565001 2-GB memory module for use with all computer models (DDR3, 10600, 1333-MHz)

621569-001 4-GB memory module for use with all computer models (DDR3, 10600, 1333-MHz)

622643-001 320-GB, 5400-rpm hard drive (2.5-in, SATA, does not include bracket, connector cable, Mylar
shield, or screws)

630703-001 Ralink 5390GN 802.11b/g/n 1x1 WiFi Adapter for use with all computer models

630705-001 Ralink RT3090BC4 802.11b/g/n 1x1 WiFi and Bluetooth 2.1+EDR Combo adapter (BT3.0+HS
ready) for use only with computer models equipped with an Intel processor

631252-001 Intel Core i7-2620M 2.70-GHz (SC turbo up to 3.40-GHz) processor (1333-MHz FSB, 4.0-MB L3
cache, dual core, 35 W, includes replacement thermal material)

631253-001 Intel Core i5-2520M 2.50-GHz (SC turbo up to 3.20-GHz) processor (1333-MHz FSB, 3.0-MB L3
cache, dual core, 35 W, includes replacement thermal material)

631254-001 Intel Core i7-2720QM 2.20-GHz (SC turbo up to 3.00-GHz) processor (1600-MHz FSB, 6.0-MB L3
cache, quad core, 45 W, includes replacement thermal material)

631255-001 Intel Core i5-2540M 2.60-GHz (SC turbo up to 3.30-GHz) processor (1333-MHz FSB, 3.0-MB L3
cache, dual core, 35 W, includes replacement thermal material)

631956-001 Intel Centrino Advanced-N 6230 WLAN module for use only with computer models equipped with

an Intel processor
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Spare part number

Description

633252-001 750-GB, 7200-rpm hard drive (2.5-in, SATA, does not include bracket, connector cable, Mylar
shield, or screws)

633817001 Intel Centrino Wireless-N + WiMAX 6150 WLAN module for use only with computer models
equipped with an Intel processor

634091-001 8-GB memory module for use only with computer models equipped with an Intel processor (DDR3,
10600, 1333-MHz)

634250-001 750-GB, 5400-rpm hard drive (2.5-in, SATA, does not include bracket, connector cable, Mylar
shield, or screws)

634694-001 Intel Core i7-2820QM 2.30-GHz (SC turbo up to 3.10-GHz) processor (1600-MHz FSB, 8.0-MB L3
cache, quad core, 45 W, includes replacement thermal material)

634862-001 320-GB, 7200-rpm hard drive (2.5-in, SATA, does not include bracket, connector cable, Mylar
shield, or screws)

634932-001 500-GB, 5400-rpm hard drive (2.5-in, SATA, does not include bracket, connector cable, Mylar
shield, or screws)

635501-001 Intel Core i7-2630QM 2.00-GHz (SC turbo up to 2.90-GHz) processor (1600-MHz FSB, 6.0-MB L3
cache, quad core, 45 W, includes replacement thermal material)

636631-001 9-cell, 100-WHr, 3.00-AHr, Li battery

638974-001 1-TB, 5400-rpm hard drive (2.5-in, SATA, does not include bracket, connector cable, Mylar shield,
or screws)

640926-001 Realtek 8188GN 802.11b/g/n 1x1 WiFi Adapter for use with all computer models

641369001 4-GB memory module for use only with computer models equipped with an AMD processor (DDR3,
12800, 1600-MHz)

653338-001 Intel Pentium B950 TJ85 2.10-GHz processor (2.0-MB L3 cache, dual core, 35 W; includes
replacement thermal material)

653339-001 Intel Core i3-2330M 2.20-GHz processor (3.0-MB L3 cache, dual core, 35 W; includes
replacement thermal material)

653340-001 Intel Core i3-2350M 2.30-GHz processor (3.0-MB L3 cache, dual core, 35 W; includes
replacement thermal material)

653341-001 Intel Core i5-2430M 2.40-GHz (SC turbo up to 3.00-GHz) processor (3.0-MB L3 cache, dual core,
35 W; includes replacement thermal material)

653348-001 AMD A4-3300M 2.50-GHz processor (1.90-GHz FSB, 4.0-MB L2 cache, dual core, 35 W;
includes replacement thermal material)

653349-001 AMD A6-3400M 2.30-GHz processor (1.40-GHz FSB, 4.0-MB L2 cache, dual core, 35 W;
includes replacement thermal material)

653350-001 AMD A8-3500M 2.40-GHz processor (1.50-GHz FSB, 4.0-MB L2 cache, quad core, 35 W;
includes replacement thermal material)

653351-001 AMD E2-3000M 2.40-GHz processor (1.80-GHz FSB, 2.0-MB L2 cache, dual core, 35 W;
includes replacement thermal material)

653356-001 AMD A4-3310MX 2.50-GHz processor (2.10-GHz FSB, 2.0-MB L2 cache, dual core, 45 W;

includes replacement thermal material)
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Spare part number

Description

653357-001 AMD A6-3410MX 2.30-GHz processor (1.60-GHz FSB, 2.0-MB L2 cache, quad core, 45 W;
includes replacement thermal material)

653358-001 AMD A8-3510MX 2.50-GHz processor (1.50-GHz FSB, 4.0-MB L2 cache, quad core, 45 W;
includes replacement thermal material)

653364-001 AMD A8-3530MX 2.60-GHz processor (1.90-GHz FSB, 4.0-MB L2 cache, quad core, 45 W;
includes replacement thermal material)

655795-001 Atheros 9485GN 802.11b/g/n 1x1 WiFi and 3012 Bluetooth 4.0 Combo Adapter for use only
with computer models equipped with an AMD processor

657325-001 Broadcom 4313GN 802.11b/g/n 1x1 WiFi and 20702 Bluetooth 4.0 Combo Adapter for use
only with computer models equipped with an AMD processor

664662-001 Intel Pentium B960 TJ85 2.20-GHz processor (2.0-MB L3 cache, dual core, 35 W; includes
replacement thermal material)

665116-001 Intel Core i7-2670QM 2.20-GHz (SC turbo up to 3.10-GHz) processor (1600-MHz FSB, 6.0-MB L3
cache, quad core, 45 W; includes replacement thermal material)

665285001 Thermal Material Kit for use only with computer models equipped with an AMD processor and a
graphics subsystem with UMA memory (includes replacement thermal pads and paste)

665286001 Thermal Material Kit for use only with computer models equipped with an AMD processor and a
graphics subsystem with discrete memory (includes replacement thermal pads and paste)

665310001 Fingerprint reader board (includes bracket, but does not include cable)

665331001 USB board (does not include cable)

665353-001 Thermal Material Kit for use only with computer models equipped with an Intel processor and a
graphics subsystem with UMA memory (includes replacement thermal pads and paste)

665354-001 Thermal Material Kit for use only with computer models equipped with an Intel processor and a
graphics subsystem with 1024-MB of discrete memory (includes replacement thermal pads
and paste)

665355-001 Thermal Material Kit for use only with computer models equipped with an Intel processor and a
graphics subsystem with 2048-MB of discrete memory (includes replacement thermal pads
and paste)

665365-001 Webcamera/microphone module

665591-001 Antenna Kit (includes left and right wireless antenna cables and transceivers)

665592001 Display bezel

665593001 Cable Kit (includes fingerprint reader board cable, power button board cable, SD Card reader
board cable, TouchPad cable, TouchPad button board cables, and USB board cable)

665594-001 Display Cable Kit (includes display panel cable and webcamera/microphone module cable)

665595-001 Bluetooth module cable (for use only with computer models equipped with an Intel processor)

665596-001 Power connector cable

665597001 Hard Drive Hardware Kit (includes hard drive bracket and screws)

665599-001 Display Hinge Kit (includes left and right display hinges and brackets)

665600001 Power button board (does not include cable)
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Spare part number

Description

665602-001 SD Card reader board (does not include cable)

665603-001 Display lid switch board (includes cable)

665604-001 Plastics Kit (includes the service cover)

665606-001 RTC battery (includes cable and double-sided tape)

665607001 Display Rubber Kit

665608-001 Screw Kit

665609-001 Display Screw Kit

665610001 Speaker Kit (includes front speakers and cables, rear speakers and cables, and rear speaker grill)

665611-001 Subwoofer (includes isolators and cable)

665976-001 Display enclosure in dark umber finish

665977-001 Display enclosure in steel gray finish

665978-001 Base enclosure (includes battery release latch and 4 rubber feet)

665985-001 160-GB solid-state drive (does not include bracket, connector cable, shield, or screws)

665986001 System board for use only with computer models equipped with the Intel 6490 chipset, a
quad core processor, and a graphics subsystem with 1024-MB of discrete memory (includes
replacement thermal material)

665987-001 System board for use only with computer models equipped with the Intel 6490 chipset, a
dual core processor, and a graphics subsystem with 1024-MB of discrete memory (includes
replacement thermal material)

665988-001 System board for use only with computer models equipped with the Intel 6770 chipset, a
quad core processor, and a graphics subsystem with 1024-MB of discrete memory (includes
replacement thermal material)

665989-001 System board for use only with computer models equipped with the Intel 6770 chipset, a
dual core processor, and a graphics subsystem with 1024-MB of discrete memory (includes
replacement thermal material)

665990-001 System board for use only with computer models equipped with the Intel HM65 chipset, a
dual core processor, and a graphics subsystem with UMA memory (includes replacement
thermal material)

665991-001 System board for use only with computer models equipped with the Intel 6770 chipset, a
quad core processor, and a graphics subsystem with 2048-MB of discrete memory (includes
replacement thermal material)

665992-001 System board for use only with computer models equipped with the Intel 6770 chipset, a
dual core processor, and a graphics subsystem with 2048-MB of discrete memory (includes
replacement thermal material)

665993-001 System board for use only with computer models equipped with the Intel HM65 chipset, a
quad core processor, and a graphics subsystem with UMA memory (includes replacement
thermal material)

665998-001 Top cover in dark umber finish (includes TouchPad and TouchPad cable and TouchPad button

board and TouchPad button board cable)
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665999-001 Top cover in steel gray finish (includes TouchPad and TouchPad cable and TouchPad button board
and TouchPad button board cable)

666001-001 Keyboard for use with all computer models in the United States (includes keyboard cable)

666001-031 Keyboard for use with all computer models in the United Kingdom and Singapore (includes
keyboard cable)

666001041 Keyboard for use with all computer models in Germany (includes keyboard cable)

666001051 Keyboard for use with all computer models in France (includes keyboard cable)

666001061 Keyboard for use with all computer models in ltaly (includes keyboard cable)

666001-071 Keyboard for use with all computer models in Spain (includes keyboard cable)

666001-121 Keyboard for use with all computer models in Canada (includes keyboard cable)

666001-131 Keyboard for use with all computer models in Portugal (includes keyboard cable)

666001-141 Keyboard for use with all computer models in Turkey (includes keyboard cable)

666001-171 Keyboard for use only with computer models equipped with an Intel processor in Saudi Arabia
(includes keyboard cable)

666001-211 Keyboard for use with all computer models in Hungary (includes keyboard cable)

666001-251 Keyboard for use with all computer models in Russia (includes keyboard cable)

666001-281 Keyboard for use only with computer models equipped with an Intel processor in Thailand (includes
keyboard cable)

666001-291 Keyboard for use only with computer models equipped with an Intel processor in Japan (includes
keyboard cable)

666001-A41 Keyboard for use with all computer models in Belgium (includes keyboard cable)

666001-AB1 Keyboard for use only with computer models equipped with an Intel processor in Taiwan (includes
keyboard cable)

666001-AD1 Keyboard for use only with computer models equipped with an Intel processor South Korea
(includes keyboard cable)

666001-B31 Keyboard for use with all computer models in the Netherlands (includes keyboard cable)

666001-BA1 Keyboard for use with all computer models in Slovenia (includes keyboard cable)

666001-BB1 Keyboard for use only with computer models equipped with an Intel processor in Israel (includes
keyboard cable)

666001-BG1 Keyboard for use with all computer models in Switzerland (includes keyboard cable)

666001-D61 Keyboard for use only with computer models equipped with an Intel processor inlndia (includes
keyboard cable)

666001-DH1 Keyboard for use with all computer models in Denmark, Finland, and Norway (includes
keyboard cable)

666001-DJ1 Keyboard for use with all computer models in Greece (includes keyboard cable)

666001-FL1 Keyboard for use with all computer models in the Czech Republic and Slovakia (includes

keyboard cable)
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Description

666173-001 Intel Core i7-2640M 2.80-GHz (SC turbo up to 3.50-GHz) processor (1333-MHz FSB, 4.0-
MB L3 cache, dual core, 35 W; includes replacement thermal material)

666174-001 Intel Core i7-2760QM 2.40-GHz (SC turbo up to 3.50-GHz) processor (1600-MHz FSB, 6.0-
MB L3 cache, quad core, 45 W; includes replacement thermal material)

666175-001 Intel Core i7-2860QM 2.50-GHz (SC turbo up to 3.60-GHz) processor (1600-MHz FSB, 8.0-
MB L3 cache, quad core, 45 W; includes replacement thermal material)

666390001 Fan/heat sink assembly for use only with computer models equipped with an Intel processor and a
graphics subsystem with 1024-MB discrete memory (includes replacement thermal material)

666391001 Fan/heat sink assembly for use only with computer models equipped with an Intel processor and a
graphics subsystem with 2048-MB discrete memory (includes replacement thermal material)

666392001 Fan/heat sink assembly for use only with computer models equipped with an Intel processor and a
graphics subsystem with UMA memory (includes replacement thermal material)

666393-001 Blu-ray Disc R/RW FX SuperMulti Drive for use with all computer models (includes bezel,
bracket, cable, and screws)

666394-001 Blu-ray Disc ROM FX SuperMulti DVD+R/RW Double-Layer Drive (includes bezel, bracket, cable,
and screws)

666395-001 DVD+RW Double-Layer FX SuperMulti Drive for use only with computer models equipped with an
Intel processor (includes bezel, bracket, cable, and screws)

666396-001 17.3-in, HD+, LED, BrightView display panel for use with all computer models

666397001 17.3-in, FHD, LED, AntiGlare display panel for use only with computer models equipped with an
Intel processor

666518001 System board for use only with computer models equipped with an AMD processor, a graphics
subsystem with UMA memory, and USB version 3.0 (includes replacement thermal material)

666520-001 System board for use only with computer models equipped with an AMD processor and a graphics
subsystem with discrete memory (includes replacement thermal material)

666526-001 Fan/heat sink assembly for use only with computer models equipped with an AMD processor and a
graphics subsystem with UMA memory (includes replacement thermal material)

666527001 Fan/heat sink assembly for use only with computer models equipped with an AMD processor and a
graphics subsystem with discrete memory (includes replacement thermal material)

669686-001 AMD A4-3320MX 2.60-GHz processor (2.00-GHz FSB, 2.0-MB L2 cache, dual core, 45 W;
includes replacement thermal material)

669687-001 AMD A4-3330MX 2.60-GHz processor (2.40-GHz FSB, 2.0-MB L2 cache, dual core, 45 W;
includes replacement thermal material)

669688-001 AMD A6-3420M 2.40-GHz processor (1.50-GHz FSB, 4.0-MB L2 cache, quad core, 45 W;
includes replacement thermal material)

669689-001 AMD A6-3430MX 2.40-GHz processor (1.70-GHz FSB, 4.0-MB L2 cache, quad core, 45 W;
includes replacement thermal material)

669690-001 AMD A8-3520M 2.50-GHz processor (1.60-GHz FSB, 4.0-MB L2 cache, quad core, 45 W;
includes replacement thermal material)

669691-001 AMD A8-3550MX 2.70-GHz processor (2.00-GHz FSB, 4.0-MB L2 cache, quad core, 45 W;

includes replacement thermal material)
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Description

672093-001 AMD A4-3305M 2.50-GHz processor (1.90-GHz FSB, 4.0-MB L2 cache, dual core, 45 W;
includes replacement thermal material)

676359-001 Intel Core i5-2450M 2.50-GHz processor (SC turbo up to 3.10-GHz), 3.0-MB L3 cache, 1333-
MHz FSB, dual core, 35 W; includes replacement thermal material)

676785-001 Intel Pentium B970 TJ85 2.30-GHz processor (2.0-MB L3 cache, dual core, 35 W; includes
replacement thermal material)

677152-001 Intel Core i3-2370M 2.40-GHz processor (3.0-MB L3 cache, dual core, 35 W; includes
replacement thermal material)

682679001 160-GB solid-state drive for use only on computer models equipped with an AMD processor (does

not include bracket, connector cable, Mylar shield, or screws)
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4 Removal and replacement
procedures

Preliminary replacement requirements

Tools required

You will need the following tools to complete the removal and replacement procedures:

Flat-bladed screwdriver

®  Magnetic screwdriver

Phillips PO and P1 screwdrivers

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

E‘/fNOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

/\ CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use
care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.

Cables and connectors

/\ CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with
extreme care; these cables tear easily.
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Drive handling

/\ CAUTION: Drives are fragile components that must be handled with care. To prevent damage to

the computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether
the computer is off or in Hibernation, turn the computer on, and then shut it down through the
operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.
Avoid dropping drives from any height onto any surface.
After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing an internal hard drive to products that have magnetic fields, such as monitors
or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

Grounding guidelines

Electrostatic discharge damage

42

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.
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/\ CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Before touching an electronic component, discharge static electricity by using the guidelines described

in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by

different activities.

/\ CAUTION: A product can be degraded by as litle as 700 V.

Typical electrostatic voltage levels

Relative humidity

Event 10% 40% 55%
Walking across carpet 35,000 V 15,000 V 7,500V
Walking across vinyl floor 12,000 V 5,000 V 3,000 V
Motions of bench worker 6,000 V 800V 400V
Removing DIPS from plastic tube 2,000V 700V 400V
Removing DIPS from vinyl tray 11,500 V 4,000 vV 2,000V
Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V
Removing bubble pack from PCB 26,500 V 20,000 V 7,000V
Packing PCBs in foam-lined box 21,000V 11,000 V 5,000 V

Preliminary replacement requirements
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.
Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

Place items on a grounded surface before removing items from their containers.

Always be properly grounded when touching a component or assembly.

Store reusable ESD-sensitive parts from assemblies in protective packaging or
nonconductive foam.

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

44

Follow these grounding workstation guidelines:

Cover the workstation with approved static-shielding material.

Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-
safe materials.

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids
and Styrofoam.

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

Avoid contact with pins, leads, or circuitry.

Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm +10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive must be
worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

Antistatic tape

Antistatic smocks, aprons, and sleeve protectors

Conductive bins and other assembly or soldering aids
Nonconductive foam

Conductive tabletop workstations with ground cords of one megohm resistance
Static-dissipative tables or floor mats with hard ties to the ground
Field service kits

Static awareness labels

Material-handling packages

Nonconductive plastic bags, tubes, or boxes

Metal tote boxes

Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level
Antistatic plastics Bags 1,500 V
Carbon-loaded plastic Floor mats 7,500 V
Metallized laminate Floor mats 5,000 V

Preliminary replacement requirements
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Component replacement procedures

This chapter provides removal and replacement procedures.

There are as many as 103 screws that must be removed, replaced, or loosened when servicing
the computer. Make special note of each screw and screw lock size and location during removal
and replacement.

Service tag

When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag. When ordering parts or requesting information, provide
the computer serial number and model description provided on the service tag.

( [/ 0000
Serial: 20000000C  ININIWAR W0 ImEmEn

—Produd: XO00000CC INNMEMEINNNNIN
__Warranty: 1yly0y

e

Item Description Function

(1) Product name This is the product name affixed to the front of
the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to
each product.

(3) Part number/Product number (p/n) This number provides specific information about the
product's hardware components. The part number
helps a service technician to determine what
components and paris are needed.

46 Chapter 4 Removal and replacement procedures



Item Description Function

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model description This is the alphanumeric identifier needed to locate
documents, drivers, and support for the computer.

Computer feet

The computer feet are adhesive-backed rubber pads. There are 4 rubber feet that attach to the
base enclosure in the locations illustrated below.

Battery
Description Spare part number
9-cell, T00-WHr, 3.00-AHr, LI 636631-001
6-cell, 62-WHr, 2.80-AHr, LI 593562-001
6-cell, 55-WHr, 2.55-AHr, LI 593554-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.
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Remove the battery:
1. Slide the release latch (1) to release the battery.
2. Pivot the front edge of the battery (2) up and back.

3. Remove the battery (3) from the computer.

°1

To insert the battery:
1. Align the tabs on the rear edge of the battery with the notches on the rear edge of the battery bay.
2. Pivot the front edge of the battery down into the battery bay until it is seated. (The battery release

latch will automatically lock into place.)

Optical drive

B/ NOTE:  The optical drive spare part kit includes a bezel and bracket.

Description Spare part number
Blu-ray Disc ROM FX SuperMulti DVD+R/RW Double-Layer Drive 666394001
Blu-ray Disc R/RW FX SuperMulti Drive 666393-001

DVD+RW Double-Layer FX SuperMulti Drive (for use only with computer models equipped with an 666395001
Intel processor)

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.
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3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47).

Remove the optical drive:
1. Slide the release latch (1) to release the service cover from the computer.

2. Lift the rear edge of the service cover (2) up and forward until it rests at an angle.

3. Remove the service cover. The service cover is available in the Plastics Kit, spare part number
665604-001.

4. Remove the Phillips PM2.5x5.0 screw that secures the optical drive to the computer.

5. Push on the hard drive bracket (1) to release the optical drive.
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6. Remove the optical drive (2) from the computer.

7. Ifitis necessary to replace the optical drive bracket, position the optical drive with the rear panel
toward you.

8. Remove the two Phillips PM2.0x4.0 screws (1) that secure the bracket to the optical drive.

9. Remove the optical drive bracket (2). The optical drive bracket is included in the optical drive
spare part kit.

Reverse this procedure to reassemble and install the optical drive.
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Hard drive

E"%NOTE: The hard drive spare part kit does not include the bracket, connector cable, Mylar shield,
or screws. The bracket, connector cable, Mylar shield, and screws are included in the Hard Drive

Hardware Kit, spare part number 665597-001.

E"%NOTE: The computer can be equipped with up to two hard drives. The primary hard drive is installed
in the right hard drive bay. The secondary hard drive is installed in the left hard drive bay.

Description Spare part number
1-TB, 5400-rpm, 12.7-mm 638974-001
750-GB, 7200-rpm, 9.5-mm 633252-001
750-GB, 5400-rpm, 9.5-mm 634250-001
640-GB, 5400-rpm, 9.5-mm 603785-001
500-GB, 7200-rpm, 9.5-mm 608218-001
500-GB, 5400-rpm, 9.5-mm 634932-001
320-GB, 7200-rpm, 9.5-mm 634862-001
320-GB, 5400-rpm, 9.5-mm 622643-001

160-GB solid-state drive (does not include bracket, connector cable, Mylar shield, or screws):

For use only on computer models equipped with an AMD processor 682679-001

For use only on computer models equipped with an Intel processor 665985-001

Before removing a hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47).

5. Remove the service cover (see Optical drive on page 48).

Remove the hard drive:

E’%NOTE: Steps 1 through 3 apply to the primary hard drive. See steps 4 through 7 for secondary

hard drive removal information.

1. Disconnect the hard drive cable (1) from the system board.

2. Remove the four Philllips PM2.5x5.0 screws (2) that secure the hard drive to the computer.
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3. Remove the hard drive (3).

Disconnect the hard drive cable (1) from the system board.
Release the hard drive cable (2) from the routing channel built into the base enclosure.

Remove the four Philllips PM2.5x5.0 screws (3) that secure the hard drive to the computer.

A S

Remove the hard drive (4).

8. |Ifitis necessary to replace the hard drive bracket or hard drive connector cable:

a. Remove the four Phillips PM3.0x4.0 screws (1) that secure the hard drive bracket to the
hard drive.

b. Remove the hard drive bracket (2) from the hard drive.
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c. Disconnect the hard drive connector cable (3) from the hard drive.

E'%NOTE: The hard drive connector cable used on the secondary hard drive has a
longer cable.

Reverse this procedure to reassemble and install the mass storage device.
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RTC battery

Description Spare part number

RTC battery (includes cable and double-sided tape) 665606-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47).

5. Remove the service cover (see Optical drive on page 48).

Remove the RTC battery:
1. Disconnect the RTC battery cable (1) from the system board.
2. Release the clips (2) built into the base enclosure that secure the RTC battery.

3. Remove the RTC battery (3). (The RTC battery is attached to the base enclosure with double-
sided tape.)

Reverse this procedure to install the RTC battery.
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Memory module

E"%NOTE: The computer can be equipped with up to two memory modules. The primary memory module
is installed in the memory module socket closest to the system board. The expansion memory module is
installed in the memory module socket farthest from the system board.

Description Spare part number

For use with all computer models:

4-GB memory module (DDR3, 10600, 1333-MHz) 621569-001

2-GB memory module (DDR3, 10600, 1333-MHz) 621565-001

4-GB memory module for use only with computer models equipped with an AMD processor (DDR3, ~ 641369-001
12800, 1600-MHz)

8-GB memory module for use only with computer models equipped with an Intel processor (DDR3, 634091-001
10600, 1333-MHz)

Before removing a memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47).

5. Remove the service cover (see Optical drive on page 48).

Remove the memory module:

1. Spread the retaining tabs (1) on each side of the memory module slot to release the
memory module. (The memory module tilts up.)
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2. Remove the memory module (2) by pulling it away from the slot at an angle.

Reverse this procedure to install a memory module.

WLAN module

Description Spare part number

For use with all computer models:

Ralink 5390GN 802.11b/g/n 1x1 WiFi Adapter 630703-001

Realtek 8188GN 802.11b/g/n 1x1 WiFi Adapter 640926-001

For use only with computer models equipped with an AMD processor:

Atheros 9485GN 802.11b/g/n 1x1 WiFi and 3012 Bluetooth 4.0 Combo Adapter 655795-001

Atheros ARP002WB-TNGB 802.11b/g/n 1x1 WiFi and Bluetooth 2.1EDR+ Combo Adapter 593127-001
(BT3.0+HS ready)

Broadcom 4313 802.11b/g/n 1x1 WiFi and 2070 Bluetooth 2.1+EDR Combo adapter 600370-001
(BT3.0+HS ready)

Broadcom 4313GN 802.11b/g/n 1x1 WiFi and 20702 Bluetooth 4.0 Combo Adapter 657325-001

For use only with computer models equipped with an Intel processor:

Broadcom 4313 802.11b/g/n 1x1 WiFi Adapter 593836-001
Intel Centrino Advanced-N 6230 WLAN module 631956-001
Intel Centrino Wireless-N + WiMAX 6150 WLAN module 633817-001
Intel Centrino Wireless-N 1000 802.11b/g/n 1x2 WLAN module 593530-001
Ralink RT3090BC4 802.11b/g/n 1x1 WiFi and Bluetooth 2.1+EDR Combo adapter 630705-001

(BT3.0+HS ready)
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/\ CAUTION: To prevent an unresponsive system, replace the wireless module only with a

wireless module authorized for use in the computer by the governmental agency that regulates wireless

devices in your country or region. If you replace the module and then receive a warning message,
remove the module to restore device functionality, and then contact technical support.

Before removing the WLAN module, follow these steps:

4.
5.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 47).

Remove the service cover (see Optical drive on page 48).

Remove the WLAN module:

1.

@NOTE: The #1 WLAN antenna cable is connected to the WLAN module Main terminal. The #2
WILAN antenna cable is connected to the WLAN module Aux terminal.

Disconnect the WLAN antenna cables from the terminals on the WLAN module.
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2. Remove the two Phillips PM2.0x4.0 screws that secure the WLAN module to the system board.
(The WLAN module tilts up.)

3. Remove the WLAN module by pulling the module away from the slot at an angle.

%/%"NOTE: If the WLAN antennas are not connected to the terminals on the WLAN module, the protective
sleeves must be installed on the antenna connectors, as shown in the following illustration.

"-\.\H

Reverse this procedure fo install the WLAN module.
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Keyboard

E’%NOTE: The keyboard spare part kit includes a keyboard cable.

Description Spare part number Description Spare part number

For use with all computer models:

For use in Belgium 666001-A41 For use in the Netherlands 666001-B31
For use in Canada 666001-121 For use in Portugal 666001-131
For use in the Czech Republic and 666001-FL1 For use in Russia 666001-251
Slovakia

For use in Denmark, Finland, and 666001-DH1 For use in Slovenia 666001-BAT
Norway

For use in France 666001-051 For use in Spain 666001-071
For use in Germany 666001-041 For use in Switzerland 666001-BG1
For use in Greece 666001-DJ1 For use in Turkey 666001-141
For use in Hungary 666001-211 For use in the United Kingdom and ~ 666001-031

Singapore

For use in ltaly 666001-061 For use in the United States 666001-001
For use only with computer models equipped with an For use in Saudi Arabia 666001-171
Intel processor:

For use in India 666001-D61 For use in South Korea 666001-AD1
For use in Israel 666001-BB1 For use in Taiwan 666001-AB1
For use in Japan 666001-291 For use in Thailand 666001-281

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47).

5. Remove the optical drive (see Optical drive on page 48).
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Remove the keyboard:

1. Remove the two Phillips PM2.5x5.0 screws that secure the keyboard to the computer.

2. Rest the computer on its right side.

3. Open the computer.

4. Insert a screw driver or similar thin tool into the keyboard screw hole, and then press on the back
of the keyboard until the keyboard disengages from the computer.

5. Turn the computer rightside up with the front toward you.
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6. Lift the rear edge of the keyboard (1), and then slide the keyboard (2) back until the
keyboard cable connector is accessible.

7. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached, and
then disconnect the keyboard cable (2) from the system board.
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8. Remove the keyboard.

Reverse this procedure to install the keyboard.
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Top

cover

@NOTE: The top cover spare part kit includes the TouchPad and TouchPad cable and the TouchPad

button board and TouchPad button board cable.

Description Spare part number
In dark umber finish 665998-001
In steel gray finish 665999001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47), and then remove the following components:

e  Optical drive (see Optical drive on page 48)

e  Hard drive (see Hard drive on page 51)

e Keyboard (see Keyboard on page 59)

When replacing the top cover, be sure that the following components are removed from the defective
top cover and installed on the replacement top cover:

e  Fingerprint reader board and cable (see Fingerprint reader board on page 66)

®  Power button board and cable (see Power button board on page 68)

e Display lid switch board and cable (see Display lid switch board on page 70)

Remove the top cover:
1. Close the computer.

2. Turn the computer upside down, with the front toward you.
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3. Remove the eight Phillips PM2.5x5.0 screws that secure the top cover to the computer.
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4. Remove the following screws:
(1) One Phillips PM2.5x7.0 screw in the rear left corner of the base enclosure
(2) Three Philllips PM2.5%3.0 screws in the optical drive bay

(3) Two Phillips PM2.5x9.0 screws on the right side of the base enclosure

5. Turn the computer rightsside up, with the front toward you.

6. Open the computer.
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7. Release the ZIF connectors to which the following cables are attached, and then disconnect
the cables from the system board:

(1) Power button board cable
(2) TouchPad bution board cable
(3) Fingerprint reader board cable
(4) USB board cable

8. Remove the two Phillips PM2.5x5.0 screws that secure the top cover to the computer.

=2 NOTE: As you prepare to release the top cover, make sure the USB board (2) cable feeds freely
through the opening (3) in the top cover.

9. Lift the rear edge of the top cover (1) until the left and right sides disengage from the
base enclosure.

64 Chapter 4 Removal and replacement procedures



10. Remove the top cover (2).

Reverse this procedure to install the top cover.
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Fingerprint reader board

@NOTE: The fingerprint reader board does not include the fingerprint reader board cable. The
fingerprint reader board cable is included in the Cable Kit, spare part number 665593-001.

Description Spare part number

Fingerprint reader board (includes bracket) 665310-001

Before removing the fingerprint reader board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47), and then remove the following components:

e Optical drive (see Optical drive on page 48)

e  Hard drive (see Hard drive on page 51)

e Keyboard (see Keyboard on page 59)

®  Top cover (see Top cover on page 62)

Remove the fingerprint reader board, bracket, and cable:
1. Turn the top cover upside down, with the front toward you.

2. Release the fingerprint reader board cable (1) from the surface of the top cover. Remove the two
Phillips PM2.0x2.0 screws (2) that secure the fingerprint reader board and bracket to the
top cover.
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3. Remove the fingerprint reader board bracket (3), board (4), and cable.

Reverse this procedure to install the fingerprint reader board, bracket, and cable.
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Power button board

@NOTE: The power button board does not include the power button board cable. The power button
board cable is included in the Cable Kit, spare part number 665593-001.

Description Spare part number

Power button board 665600-001

Before removing the power button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47), and then remove the following components:

e Optical drive (see Optical drive on page 48)

e  Hard drive (see Hard drive on page 51)

e Keyboard (see Keyboard on page 59)

®  Top cover (see Top cover on page 62)

Remove the power button board:

1. Turn the top cover upside down, with the front toward you.

2. Release the power button board cable from the tab (1) on the top cover.

3. Disconnect the display lid switch board cable (2) from the power button board.
4

Remove the two Phillips PM2.0x4.0 screws (3) that secure the power button board to the
top cover.
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5. Remove the power button board and cable (4).

Reverse this procedure to install the power button board.
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Display lid switch board

Description Spare part number

Display lid switch board (includes cable) 665603-001

Before removing the display lid switch board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47), and then remove the following components:

e Optical drive (see Optical drive on page 48)

e  Hard drive (see Hard drive on page 51)

e Keyboard (see Keyboard on page 59)

®  Top cover (see Top cover on page 62)

Remove the display lid switch board:
1. Turn the top cover upside down, with the front toward you.
2. Disconnect the display lid switch cable (1) from the power button board.

3. Release the display lid switch board cable from the clips (2) built into the top cover.
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4. Release the display lid switch board from the clips (3) built into the top cover.

5. Remove the display lid switch board and cable.

Reverse this procedure to install the display lid switch board and cable.
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SD Card reader board

@NOTE: The SD Card reader board does not include the SD Card reader board cable. The SD Card
reader board cable is included in the Cable Kit, spare part number 665593-001.

Description Spare part number

SD Card reader board 665602-001

Before removing the SD Card reader board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47), and then remove the following components:

e Optical drive (see Optical drive on page 48)

e  Hard drive (see Hard drive on page 51)

e Keyboard (see Keyboard on page 59)

®  Top cover (see Top cover on page 62)

Remove the SD Card reader board and cable:

1. Release the ZIF connector to which the SD Card reader board cable is connected, and then
disconnect the SD Card reader board cable (1) from the system board.

2. Remove the two Phillips PM2.5x5.0 screws (2) that secure the SD Card reader board to the
base enclosure.

72 Chapter 4 Removal and replacement procedures



3. Remove the SD Card reader board (3) and cable.

Reverse this procedure to install the SD Card reader board and cable.
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Bluetooth module

@NOTE: This section applies only to computer models equipped with an Intel processor.

@NOTE: The Bluetooth module does not include the Bluetooth module cable. The
Bluetooth module cable is available using spare part number 665595-001.

Description Spare part number

Bluetooth module 537921-001

Before removing the Bluetooth module and cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47), and then remove the following components:

e Optical drive (see Optical drive on page 48)

e  Hard drive (see Hard drive on page 51)

e Keyboard (see Keyboard on page 59)

®  Top cover (see Top cover on page 62)

Remove the Bluetooth module and cable:
1. Disconnect the Bluetooth module cable (1) from the system board.

2. Release the Bluetooth module cable (2) from the clips built into the speaker and base enclosure.
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3. Release the Bluetooth module (3) from the clip built into the base enclosure.

4. Remove the Bluetooth module and cable.

5. Ifitis necessary to replace the Bluetooth module cable, disconnect the cable from the
Bluetooth module.

Reverse this procedure to install the Bluetooth module and cable.
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USB board

@NOTE: The USB board does not include the USB board cable. The USB board cable is included in
the Cable Kit, spare part number 665593-001.

Description Spare part number

USB board 665331-001

Before removing the USB board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47), and then remove the following components:

e Optical drive (see Optical drive on page 48)

e  Hard drive (see Hard drive on page 51)

e Keyboard (see Keyboard on page 59)

®  Top cover (see Top cover on page 62)

Remove the USB board:

1. Detach the USB board cable (1) from the base enclosure. (The USB board cable is attached to the
base enclosure with double-sided tape.)

2. Remove the two Phillips PM2.5x5.0 screws (2) that secure the USB board to the base enclosure.
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3. Remove the USB board (3) and cable.

Reverse this procedure to install the USB board and cable.
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Front speakers

@NOTE: The front speakers are included in the Speaker Kit, spare part number 665610-001.

Before removing the front speakers, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47), and then remove the following components:

e Optical drive (see Optical drive on page 48)

e  Hard drive (see Hard drive on page 51)

e  Keyboard (see Keyboard on page 59)

®  Top cover (see Top cover on page 62)

e USB board (see USB board on page 76)

Remove the front speakers and cables:
1. Disconnect the front speaker cable (1) from the system board.

2. Release the front speaker cable from the clips (2) and routing channel built into the
base enclosure.

3. Remove the two Phillips PM2.5x5.0 screws (3) that secure the front right speaker to the
base enclosure.

]
I

4. Rotate the front left speaker (1) clockwise to release it from under the system board.
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5. Remove the front left speaker (2).

6. Remove the front right speaker (3).

Reverse this procedure to install the front speakers and cables.
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Power connector cable

Description Spare part number

Power connector cable 665596-001

Before removing the power connector cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47), and then remove the following components:

e Optical drive (see Optical drive on page 48)

e  Hard drive (see Hard drive on page 51)

e Keyboard (see Keyboard on page 59)

®  Top cover (see Top cover on page 62)
Remove the power connector cable:
1. Release the power connector cable from the clips (1) built into the base enclosure.
2. Disconnect the power connector cable (2) from the system board.

3. Remove the two Phillips PM2.0x4.0 screws (3) that secure the power connector to the
base enclosure.
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4. Remove the power connector (4) from the base enclosure.

Reverse this procedure to install the power connector cable.

System board

@NOTE: The system board spare part kit includes replacement thermal material.

Description Spare part number

For use only with computer models equipped with an AMD processor:

For use only with computer models equipped with a graphics subsystem with discrete memory 666520-001

For use only with computer models equipped with a graphics subsystem with UMA memory 666518001

For use only with computer models equipped with an Intel processor:

For use only with computer models equipped with the Intel 6770 chipset, a quad core processor, and  665991-001
a graphics subsystem with 2048-MB of discrete memory

For use only with computer models equipped with the Intel 6770 chipset, a dual core processor, and  665992-001
a graphics subsystem with 2048-MB of discrete memory

For use only with computer models equipped with the Intel 6770 chipset, a quad core processor, and  665988-001
a graphics subsystem with 1024-MB of discrete memory

For use only with computer models equipped with the Intel 6770 chipset, a dual core processor, and  665989-001
a graphics subsystem with 1024-MB of discrete memory

For use only with computer models equipped with the Intel 6490 chipset, a quad core processor, and  665986-001
a graphics subsystem with 1024-MB of discrete memory

For use only with computer models equipped with the Intel 6490 chipset, a dual core processor, and  665987-001
a graphics subsystem with 1024-MB of discrete memory

For use only with computer models equipped with the Intel HMé5 chipset, a quad core processor, 665993001
and a graphics subsystem with UMA memory
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Description Spare part number

For use only with computer models equipped with the Intel HMé5 chipset, a dual core processor, 665990001
and a graphics subsystem with UMA memory

Thermal Material Kit (includes replacement thermal pads and paste):

For use only with computer models equipped with an AMD processor and a graphics subsystem with  665286-001
discrete memory

For use only with computer models equipped with an AMD processor and a graphics subsystem with  665285-001
UMA memory

For use only with computer models equipped with an Intel processor and a graphics subsystem with ~ 665355-001
2048-MB of discrete memory

For use only with computer models equipped with an Intel processor and a graphics subsystem with ~ 665354-001
1024-MB of discrete memory

For use only with computer models equipped with an Intel processor and a graphics subsystem with ~ 665353-001
UMA memory

Before removing the system board, follow these steps:

1.

2.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 47), and then remove the following components:

Optical drive (see Optical drive on page 48)

Hard drive (see Hard drive on page 51)

WILAN module (see WLAN module on page 56)

Keyboard (see Keyboard on page 59)

Top cover (see Top cover on page 62)

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

Memory module (see Memory module on page 55)

RTC battery (see RTC battery on page 54)

Fan and heat sink (see Fan/heat sink assembly on page 85)

Processor (see Processor on page 89)
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Remove the system board:
1. Close the computer.
2. Turn the computer upside down, with the front toward you.

3. Disconnect the rear speaker cable (1) and the optical drive cable (2) from the system board.

4. Turn the computer right side up, with the front toward you.

5. Open the computer.
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6. Disconnect the following cables from the system board:
(1) Display panel cable
(2) Webcam/microphone cable
(3) Subwoofer cable

(4) Power connector cable

7.

8. Flex the left side (1) of the base enclosure outward to allow the audio connectors (2) to clear the
openings in the base enclosure.

9. Lift the front edge of the system board (3) until it rests at an angle.
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10. Remove the system board (4) by sliding it up and forward at an angle.

Reverse this procedure to install the system board.

Fan/heat sink assembly

E’%NOTE: The fan/heat sink assembly spare part kit includes replacement thermal material.

Description Spare part number

For use only with computer models equipped with an AMD processor and a graphics subsystem with  666527-001
discrete memory

For use only with computer models equipped with an AMD processor and a graphics subsystem with  666526-001
UMA memory

For use only with computer models equipped with an Intel processor and a graphics subsystem with ~ 666391-001
2048-MB of discrete memory

For use only with computer models equipped with an Intel processor and a graphics subsystem with ~ 666390-001
1024-MB of discrete memory

For use only with computer models equipped with an Intel processor and a graphics subsystem with ~ 666392-001
UMA memory

E’jNOTE: To properly ventilate the computer, allow at least 7.6 cm (3 in) of clearance on the left side of
the computer. The computer uses an electric fan for ventilation. The fan is controlled by a temperature
sensor and is designed to turn on automatically when high temperature conditions exist. These
conditions are affected by high external temperatures, system power consumption, power
management/battery conservation configurations, battery fast charging, and software requirements.
Exhaust air is displaced through the ventilation grill located on the left side of the computer.
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Before removing the fan/heat sink assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47), and then remove the following components:

e  Optical drive (see Optical drive on page 48)

e  Hard drive (see Hard drive on page 51)

e WILAN module (see WLAN module on page 56)

e Keyboard (see Keyboard on page 59)

®  Top cover (see Top cover on page 62)

e  System board (see System board on page 81)
Remove the fan/heat sink assembly:

1. Disconnect the fan cable from the system board.

2. Turn the system board upside down, with the front toward you.

E”/f’NOTE: Steps 3 and 4 apply to computer models equipped with an AMD processor. See steps 5
and 6 for fan/heat sink assembly removal information for computer models equipped with an
Intel processor.

3. Following the 1 through 9 sequence indicated on the heat sink, loosen the nine captive screws (1)
that secure the fan/heat sink assembly to the system board.

E‘%NOTE: Due to the adhesive quality of the thermal material located between the heat sink and
system board components, it may be necessary to move the fan/heat sink assembly from side to
side to detach it.

86 Chapter 4 Removal and replacement procedures



4. Remove the fan/heat sink assembly (2).

| e |

B NOTE:  The thermal material must be thoroughly cleaned from the surfaces of the heat sink and
the system board components each time the fan/heat sink assembly is removed. Replacement

thermal material is included with the fan/heat sink assembly, processor, and system board spare
part kits.

e  Thermal paste is used on the processor (1) and the heat sink section (2) that services it

e A thermal pad is used on the Northbridge chip (3) and the heat sink section (4) that
services it

[ ]

A thermal pad is used on the graphics subsystem chip (5) and the heat sink section (6) that

services it (only on computer models equipped with a graphics subsystem with
discrete memory)
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@NOTE: Steps 5 and 6 apply to computer models equipped with an Intel processor. See steps 3
and 4 for fan and heat sink removal information for computer models equipped with an
AMD processor.

5. Following the 1 through 8 sequence indicated on the heat sink, loosen the eight screws (1) that
secure the fan/heat sink assembly to the system board.

=7 NOTE: Due to the adhesive quality of the thermal material located between the heat sink and

system board components, it may be necessary to move the fan/heat sink assembly from side to
side to detach it.

6. Remove the fan/heat sink assembly (2).

B NOTE:  The thermal material must be thoroughly cleaned from the surfaces of the heat sink and
the system board components each time the fan/heat sink assembly is removed. Replacement

thermal material is included with the fan/heat sink assembly, processor, and system board spare
part kits.

e  Athermal pad is used on the capacitors (1) and the heat sink section (2) that services them
e Thermal paste is used on the processor (3) and the heat sink section (4) that services it
e A thermal pad is used on the graphics subsystem chip (5) and the heat sink section (6) that

services it (only on computer models equipped with a graphics subsystem with
discrete memory)
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Reverse this procedure to install the fan/heat sink assembly.

Processor

@NOTE: The processor spare part kit includes replacement thermal material.

Description Spare part number
AMD A8-3550MX 2.70-GHz processor (2.00-GHz FSB, 4.0-MB L2 cache, quad core, 45 W) 669691-001
AMD A8-3530MX 2.60-GHz processor (1.90-GHz FSB, 4.0-MB L2 cache, quad core, 45 W) 653364-001
AMD A8-3520M 2.50-GHz processor (1.60-GHz FSB, 4.0-MB L2 cache, quad core, 45 W) 669690-001
AMD A8-3510MX 2.50-GHz processor (1.50-GHz FSB, 4.0-MB L2 cache, quad core, 45 W) 653358-001
AMD A8-3500M 2.40-GHz processor (1.50-GHz FSB, 4.0-MB L2 cache, quad core, 35 W) 653350-001
AMD A6-3430MX 2.40-GHz processor (1.70-GHz FSB, 4.0-MB L2 cache, quad core, 45 W) 669689-001
AMD A6-3420M 2.40-GHz processor (1.50-GHz FSB, 4.0-MB L2 cache, quad core, 45 W) 669688-001
AMD A6-3410MX 2.30-GHz processor (1.60-GHz FSB, 2.0-MB L2 cache, quad core, 45 W) 653357-001
AMD A6-3400M 2.30-GHz processor (1.40-GHz FSB, 4.0-MB L2 cache, quad core, 35 W) 653349-001
AMD A4-3330MX 2.60-GHz processor (2.40-GHz FSB, 2.0-MB L2 cache, dual core, 45 W) 669687-001
AMD A4-3320MX 2.60-GHz processor (2.00-GHz FSB, 2.0-MB L2 cache, dual core, 45 W) 669686-001
AMD A4-3310MX 2.50-GHz processor (2.10-GHz FSB, 2.0-MB L2 cache, dual core, 45 W) 653356-001
AMD A4-3305M 2.50-GHz processor (1.90-GHz FSB, 4.0-MB L2 cache, dual core, 45 W) 672093-001
AMD A4-3300M 2.50-GHz processor (1.90-GHz FSB, 4.0-MB L2 cache, dual core, 35 W) 653348-001
AMD E2-3300M 2.50-GHz processor (1.90-GHz FSB, 4.0-MB L2 cache, dual core, 35 W) 653351-001

Intel Core i7-2860QM 2.50-GHz (SC turbo up to 3.60-GHz) processor (1600-MHz FSB, 8.0-MB L3 666175-001
cache, quad core, 45 W)
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Description Spare part number
Intel Core i7-2820QM 2.30-GHz (SC turbo up to 3.10-GHz) processor (1600-MHz FSB, 8.0-MB L3 634694-001
cache, quad core, 45 W)

Intel Core i7-2760QM 2.40-GHz (SC turbo up to 3.50-GHz) processor (1600-MHz FSB, 6.0-MB L3 666174-001
cache, quad core, 45 W)

Intel Core i7-2720QM 2.20-GHz (SC turbo up to 3.00-GHz) processor (1600-MHz FSB, 6.0-MB L3 631254-001
cache, quad core, 45 W)

Intel Core i7-2670QM 2.20-GHz (SC turbo up to 3.10-GHz) processor (1600-MHz FSB, 6.0-MB L3 665116-001
cache, quad core, 45 W)

Intel Core i7-2640M 2.80-GHz (SC turbo up to 3.50-GHz) processor (1333-MHz FSB, 4.0-MB L3 666173-001
cache, dual core, 35 W)

Intel Core i7-2630QM 2.00-GHz (SC turbo up to 2.90-GHz) processor (1600-MHz FSB, 6.0-MB L3 635501-001
cache, quad core, 45 W)

Intel Core i7-2620M 2.70-GHz (SC turbo up to 3.40-GHz) processor (1333-MHz FSB, 4.0-MB L3 631252-001
cache, dual core, 35 W)

Intel Core i5-2540M 2.60-GHz (SC turbo up to 3.30-GHz) processor (1333-MHz FSB, 3.0-MB L3 631255-001
cache, dual core, 35 W)

Intel Core i5-2520M 2.50-GHz (SC turbo up to 3.20-GHz) processor (1333-MHz FSB, 3.0-MB L3 631253-001
cache, dual core, 35 W)

Intel Core i5-2450M 2.50-GHz processor (SC turbo up to 3.10-GHz), 3.0-MB L3 cache, 1333-MHz  676359-001
FSB, dual core, 35 W)

Intel Core i5-2430M 2.40-GHz (SC turbo up to 3.00-GHz) processor (3.0-MB L3 cache, dual core,  653341-001
35 W)

Intel Core i3-2350M 2.30-GHz processor (3.0-MB L3 cache, dual core, 35 W) 653340-001
Intel Core i3-2370M 2.40-GHz processor (3.0-MB L3 cache, dual core, 35 W) 677152-001
Intel Core i3-2330M 2.20-GHz processor (3.0-MB L3 cache, dual core, 35 W) 653339-001
Intel Pentium B970 T)J85 2.30-GHz processor (2.0-MB L3 cache, dual core, 35 W) 676785-001
Intel Pentium B960 TJ85 2.20-GHz processor (2.0-MB L3 cache, dual core, 35 W) 664662-001
Intel Pentium B950 TJ85 2.10-GHz processor (2.0-MB L3 cache, dual core, 35 W) 653338-001

Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn

the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.
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3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47), and then remove the following components:

Optical drive (see Optical drive on page 48)

Hard drive (see Hard drive on page 51)

WILAN module (see WLAN module on page 56)

Keyboard (see Keyboard on page 59)

Top cover (see Top cover on page 62)

System board (see System board on page 81)

Fan/heat sink assembly (see Fan/heat sink assembly on page 85)

Remove the processor:

1. Use a flatbladed screw driver (1) to turn the processor locking screw one-half turn
counterclockwise (2), until you hear a click.
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2. Lift the processor (3) straight up, and remove it.

r__f"%NOTE: The gold triangle (4) on the processor must be aligned with the triangle icon embossed
on the processor socket when you install the processor.

Reverse this procedure fo install the processor.
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Optical drive cable

r__f"%NOTE: The optical drive cable is included in the optical drive spare part kit. The optical drive cable
includes the optical drive connector.

Before removing the optical drive cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47), and then remove the following components:

Optical drive (see Optical drive on page 48)

Hard drive (see Hard drive on page 51)

Keyboard (see Keyboard on page 59)

Top cover (see Top cover on page 62)

System board (see System board on page 81)

Remove the optical drive cable:

1. Release the optical drive cable (1) from the clips and routing channel built into the base enclosure.

2. Remove the two Phillips PM2.0x7.0 screws (2) that secure optical drive connector to the
base enclosure.

3. Remove the optical drive cable (2) from the base enclosure.

Reverse this procedure to install the optical drive cable.
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Rear speakers
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@NOTE: The rear speakers are included in the Speaker Kit, spare part number 665610-001.

Before removing the rear speakers, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47), and then remove the following components:

Optical drive (see Optical drive on page 48)

Hard drive (see Hard drive on page 51)

WILAN module (see WLAN module on page 56)

Keyboard (see Keyboard on page 59)

Top cover (see Top cover on page 62)

System board (see System board on page 81)

Remove the rear speakers and cables:

1. Close the computer.

2. Turn the computer upside down, with the front toward you.

3. Remove the two Phillips PM2.5x5.0 screws (1) and the three Phillips PM2.5x3.0 screws (2) that
secure the rear speakers to the computer.

4. Turn the computer right side up, with the front toward you.
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5. Open the computer.

6. Release the rear speaker cable from the clips (1) and the routing channel built into the
base enclosure. Remove the rear speaker (2).

Reverse this procedure to install the rear speakers and cables.
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Subwoofer

Description Spare part number

Subwoofer (includes isolators and cable) 665611-001

Before removing the subwoofer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 47), and then remove the following components:

e Optical drive (see Optical drive on page 48)

e  Hard drive (see Hard drive on page 51)

e WILAN module (see WLAN module on page 56)

e  Keyboard (see Keyboard on page 59)

®  Top cover (see Top cover on page 62)

e  System board (see System board on page 81)

®  Rear speakers (see Rear speakers on page 94)

Remove the rear subwoofer and cables:
1. Release the subwoofer cable (1) from the clips and routing channel built into the base enclosure.

2. Remove the two Phillips PM2.0x4.0 screws (2) and the two Phillips PM2.0x11.0 screws (3) that

secure the subwoofer to the computer.
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3.

Remove the subwoofer (4) and cables.

Reverse this procedure to install the subwoofer and cables.

Display assembly

r__i?NOTE: The display assembly is spared at the subcomponent level only. For more display assembly
spare part information, see the individual removal subsections.

Before removing the display assembly, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 47), and then remove the following components:

e  Optical drive (see Optical drive on page 48)

®  Hard drive (see Hard drive on page 51)

e  WILAN module (see WLAN module on page 56)

e Keyboard (see Keyboard on page 59)

®  Top cover (see Top cover on page 62)

e  System board (see System board on page 81)

®  Rear speakers (see Rear speakers on page 94)
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Remove the display assembly:

1. Release the wireless antenna cables from the clips (1) and the opening in the base enclosure.

/\ CAUTION: Support the display assembly when removing the following screws. Failure to
support the display assembly can result in damage to the display assembly and other
computer components.

2. Remove the six Phillips PM2.5x5.0 screws (2) and (3) that secure the display assembly to
the computer.

r__f"%NOTE: The middle screw (3) on the left hinge secures the display panel cable ground loop to
the hinge.

3. Remove the display assembly (4).
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4. |Ifitis necessary to replace the display bezel or any of the display assembly subcomponents:

a. Remove the Mylar screw covers (1) and the two Phillips PM2.5x5.0 screws (2) that secure
the display bezel to the display assembly.

—©

b. Flex the inside edges of the top edge (1), the left and right sides (2), and the bottom
edge (3) of the display bezel until the bezel disengages from the display enclosure.

c. Remove the display bezel (4). The display bezel is available using spare part number
665592-001.

oYy Ei_\r:fe
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5. Ifitis necessary to replace the display panel:

a. Remove the ten Phillips PM2.5x5.0 screws that secure the display panel to the
display enclosure.

b. Lift the top edge of the display panel, and then swing it up and forward until it rests upside
down in front of the display enclosure.
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c. Release the adhesive strip (1) that secures the display panel cable to the display panel, and
then disconnect the display panel cable (2) from the display panel.

d. Remove the display panel. The display panel is available using spare part numbers
666397-001 (17.3-in, FHD, LED, AntiGlare display panel, for use only with computer
models equipped with an Intel processor) and 666396-001 (17.3-in, HD+, LED, BrightView
display panel, for use with all computer models).

6. Ifitis necessary fo replace the webcam/microphone module:

a. Detach and release the webcam/microphone module (1) as far as the webcam/
microphone module cable allows. (The webcam/microphone module is attached to the
display enclosure with double-sided tape.)

b. Disconnect the webcam/microphone module (2) from the webcam/microphone module.

c. Remove the webcam/microphone module (3). The webcam/microphone module is available
using spare part number 665365-001.
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7. It itis necessary to replace the display hinges:

a. Remove the eight Phillips PM2.0x3.0 screws (1) that secure the display hinges to the
display panel.

b. Remove the display hinges (2). The display hinges include the display hinges and brackets
and are available using spare part number 665599-001.

A ",
o\ ks

8. Ifitis necessary to replace the display panel cable:

a. Disconnect the display logo light cable (1) from the display panel cable.

b. Release the display panel cable (2) from the clips (3) built into the display enclosure.
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c. Remove the display panel cable (4). The display panel cable includes the webcam/
microphone module cable and is available in the Display Cable Kit, spare part number
665594-001.

9. Ifitis necessary to replace the wireless antenna cables and transceivers:

a. Release the wireless antenna transceivers (1) from the display enclosure. (The wireless
antenna transceivers are attached to the display enclosure with double-sided tape.)

b. Release the wireless antenna cables from the clips (2) built info the display enclosure.
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¢. Remove the wireless antenna cables and transceivers (3). The wireless antenna cables and
transceivers are available in the Antenna Kit, spare part number 665591-001.

Reverse this procedure to reassemble and install the display assembly.
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5 Setup Utility (BIOS) and System
Diagnostics

Using Setup Utility

Setup Utility, or Basic Input/Output System (BIOS), controls communication between all the input and
output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Setup Utility
includes settings for the types of peripherals installed, the startup sequence of the computer, and the
amount of system and extended memory.

E%?NOTE: Use extreme care when making changes in Setup Utility. Errors can prevent the computer from
operating properly.

Starting Setup Utility

E‘/f'NOTE: An external keyboard or mouse connected to a USB port can be used with Setup Utility only if
USB legacy support is enabled.

To start Setup Utility, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press {10 to enter Setup Utility.

Changing the language of Setup Utility

1. Start Setup Utility.
Use the arrow keys to select System Configuration > Language, and then press enter.
Use the arrow keys to select a language, and then press enter.

When a confirmation prompt with your language selected is displayed, press enter.

A

To save your change and exit Setup Utility, use the arrow keys to select Exit > Exit Saving
Changes, and then press enter.

Your change takes effect immediately.
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Navigating and selecting in Setup Utility

To navigate and select in Setup Utility, follow these steps:

1.

2.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

e To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press entfer, or use a pointing device to click the item.

e To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

e To close open dialog boxes and return to the main Setup Utility screen, press esc, and then
follow the on-screen instructions.

E’%NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the

keyboard to navigate and make selections in Setup Utility.

Press f10 to enter Setup Utility.

To exit Setup Utility menus, choose one of the following methods:

To exit Setup Utility menus without saving your changes, click the Exit icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

—or —

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

To save your changes and exit Setup Utility menus, click the Save icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press
enter.

Your changes go into effect when the computer restarts.

Displaying system information
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1.
2.

Start Setup Utility.

Select the Main menu. System information such as the system time and date, and identification
information about the computer is displayed.

To exit Setup Utility without changing any settings, use the arrow keys to select Exit > Exit
Discarding Changes, and then press enter.
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Restoring factory settings in Setup Utility

E’%NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Setup Utility to the values that were set at the factory, follow these steps:

1.

L B O

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

Press f10 to enter Setup Utility.
Use a pointing device or the arrow keys to select File > Restore Defaults.
Follow the on-screen instructions.

To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

— Oor —

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

E’/fNOTE: Your password settings and security settings are not changed when you restore the factory
settings.

Exiting Setup Utility

To exit Setup Utility and save your changes from the current session:

If the Setup Utility menus are not visible, press esc to return to the menu display. Then use the
arrow keys to select Exit > Exit Saving Changes, and then press enter.

To exit Setup Utility without saving your changes from the current session:

If the Setup Utility menus are not visible, press esc to return to the menu display. Then use the
arrow keys to select Exit > Exit Discarding Changes, and then press enter.

Updating the BIOS

Updated versions of the BIOS may be available on the HP Web site.

Most BIOS updates on the HP Web site are packaged in compressed files called SoftPags.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.
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Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing fn
+esc (if you are already in Windows) or by using Setup Utility.

1. Start Setup Utility.
2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Setup Utility without saving your changes, click the Exit icon in the lower-left corner of the
screen, and then follow the on-screen instructions.

- or —

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

Downloading a BIOS update
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/\ CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download

and install a BIOS update only when the computer is connected to reliable external power using the AC
adapter. Do not download or install a BIOS update while the computer is running on battery power,
docked in an optional docking device, or connected to an optional power source. During the
download and installation, follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Sleep or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Windows 7—Select Start > Help and Support > Maintain.

Windows XP—Select Start > Help and Support, and then select the software and drivers
update.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you want

to download.
3. At the download areq, follow these steps:

a. Identify the BIOS update that is later than the BIOS version currently installed on your
computer. Make a note of the date, name, or other identifier. You may need this information
to locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive. Make a note
of the path to the location on your hard drive where the BIOS update is downloaded. You
will need to access this path when you are ready to install the update.

[%?NOTE: If you connect your computer to a network, consult the network administrator before
installing any software updates, especially system BIOS updates.
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BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the
download is complete. If no instructions are displayed, follow these steps:

1.

5.

Windows 7 —Open Windows Explorer by selecting Start > Computer.
Windows XP—Open Windows Explorer by selecting Start > My Computer.
Double-click your hard drive designation. The hard drive designation is typically Local Disk (C:).

Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.

Double-click the file that has an .exe extension (for example, filename.exe).
The BIOS installation begins.

Complete the installation by following the on-screen instructions.

[Bf NOTE:  After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.

Using System Diagnostics

System Diagnostics allows you to run diagnostic tests to determine if the computer hardware is
functioning properly. The following diagnostic tests are available in System Diagnostics:

Start-up test—This test analyzes the main computer components that are required to start
the computer.

Run-in test—This test repeats the start-up test and checks for intermittent problems that the start-up
test does not detect.

Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all

data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the

data to a good sector.

Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

Battery test—This test analyzes the condition of the battery. If the battery fails the test, contact HP
support to report the issue and purchase a replacement battery.

You can also view system information and error logs in the System Diagnostics window.

To start System Diagnostics:

1.

2,

Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press {2.

Click the diagnostic test you want to run, and then follow the on-screen instructions.

E’%NOTE: If you need to stop a diagnostics test while it is running, press esc.

Using System Diagnostics
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6 Specifications

Device specifications

Metric u.s.
Dimensions
Width 41.6 cm 16.4 in
Depth 27.5 cm 10.8 in
Height (front to rear) 3.2-3.6 cm 1.2-1.4 in
Weight 3.43 kg 7.57 b
Input power
Operating voltage 185Vdc@3.5A-65Wor19Vdc@4.74 A-90 W
Operating current 3.5A0r4.74 A
Temperature
Operating 5°Cto 35°C 41°F to 95°F
Nonoperating -20°C to 6°C -4°F to 140°F
Relative humidity (noncondensing)
Operating 10% to 90%
Nonoperating 5% to 95%
Maximum altitude (unpressurized)
Operating -15mto0 3,048 m -50 ft to 10,000 ft
Nonoperating -15mt0 12,192 m -50 ft to 40,000 ft

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The device operates well within this
range of temperatures.
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17.3-inch display specifications

Metric u.s.
Dimensions
Height 21.7 cm 8.54 in
Width 38.4 cm 15.12in
Diagonal 43.9 cm 17.29 in
Number of colors Up to 16.8 million
Contrast ratio 200:1 (typical)
Brightness 180 nits (typical)
Pixel resolution
Pitch 0.197 x 0.197 mm
Format 1600 x 900
Configuration RGB vertical stripe
Backlight LED
Character display 80 x 25
Total power consumption (varies by display) 2.0W
Viewing angle +65° horizontal, £50° vertical (typical)
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Hard drive specifications
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1-TB* 750-GB** 640-GB** 500-GB** 320-GB**
Dimensions
Height 12.7 mm 9.5 mm 9.5 mm 9.5 mm 9.5 mm
Length 100.2 mm 100.2 mm 100.2 mm 100.4 mm 100.4 mm
Width 69.9 mm 69.9 mm 69.9 mm 69.9 mm 69.9 mm
Weight 152 ¢ 98¢ 98¢ 110g 110g
Interface type SATA (3 GB/ SATA SATA SATA SATA

sec)
Transfer rate
Synchronous (maximum) 97 MB/sec 97 MB/sec 106 MB/sec 1.1 GB/sec 1.1 GB/sec

(internal) (internal)

Security ATA security ATA security ATA security ATA security ATA security
Seek times (typical read, including setting)
Single track 2 ms 2 ms 1.5 ms 1.5 ms 1.5 ms
Average (read/write) 12/16 ms 12/16 ms 12/13 ms 11/13 ms 11/13 ms
Maximum 21 ms 21 ms 24 ms 22 ms 22 ms
Logical blocks 1,953,525,168 1,465,149,168 1,250,263,728 976,773,168 628,142,448
Disk rotational speed 5400 rpm 7200 and 5400 7200 and 5400 7200 and 5400 7200 and 5400

rem

rem

rem

rem

Operating temperature

0°C to 60°C (32°F to 140°F)

*1 TB = 1 trillion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.

**1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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7 Backup and recovery

Your computer includes tools provided by the operating system and HP to help you safeguard your
information and restore it if ever needed.

This chapter provides information on the following topics:

e  Creating a set of recovery discs or a recovery flash drive (Recovery Manager software feature)
e  Performing a system restore (from the partition, recovery discs, or a recovery flash drive)

®  Backing up your information

®  Recovering a program or driver

Restore

In the event of hard drive failure, to restore your system to its factory image you will need a set of
recovery discs or a recovery flash drive that you can create using HP Recovery Manager. HP
recommends that you use this software to create either a set of recovery discs or a recovery flash drive
immediately after software setup.

If for some other reason you need to restore your system, this can be achieved using the HP Recovery
partition (select models only), without the need for recovery discs or a recovery flash drive. To check for
the presence of a recovery partition, click Start, right-click Computer, click Manage, and then click
Disk Management. If the recovery partition is present, a Recovery drive is listed in the window.

/\ CAUTION: HP Recovery Manager (partition, or discs/flash drive) restores only software that was
preinstalled at the factory. Software not provided with this computer must be reinstalled manually.

E’/fNOTE: Recovery discs have been included if your computer does not have a recovery partition.

Restore 113



Creating restore media
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HP recommends that you create either a set of recovery discs or a recovery flash drive to be sure that
you can restore your computer to its original factory state if the hard drive fails, or if for any reason you
cannot restore using the recovery partition tools. Create these discs or the flash drive after setting up
the computer for the first time.

@NOTE: HP Recovery Manager allows the creation of only one set of recovery discs or one recovery

flash drive. Handle these discs or flash drive carefully and keep them in a safe place.

@NOTE: If your computer does not include an integrated optical drive, you can use an optional

external optical drive (purchased separately) to create recovery discs, or you can purchase recovery
discs for your computer from the HP Web site. If you use an external optical drive, it must be connected
directly to a USB port on the computer, not to a USB port on an external device, such as a USB hub.

Guidelines:

®  Purchase high-quality DVDR, DVD+R, DVD-R DL, or DVD+R DL discs.

E’/fNOTE: Read-write discs, such as CD-RW, DVD+RW, double-layer DVD+RW, and BD-RE

(rewritable Blu-ray) discs, are not compatible with the Recovery Manager software.

®  The computer must be connected to AC power during this process.

®  Only one set of recovery discs or one recovery flash drive can be created per computer.

[Bf NOTE: If you are creating recovery discs, number each disc before inserting info the
optical drive.

e  If necessary, you can exit the program before you have finished creating the recovery discs or
recovery flash drive. The next time you open Recovery Manager, you will be prompted to continue
the backup creation process.

To create a set of recovery discs or a recovery flash drive:
1. Select Start > All Programs > Recovery Manager > Recovery Media Creation.

2. Follow the on-screen instructions.
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Performing a system restore

Recovery Manager software allows you to repair or restore the computer fo its original factory state.
Recovery Manager works from recovery discs, a recovery flash drive, or from a dedicated recovery
partition (select models only) on the hard drive.

E’%NOTE: A system restore needs to be performed if the computer hard drive has failed or if all attempts
to correct any functional computer issues fail.

A system restore should be used as a final attempt to correct computer issues.
Note the following when performing a system restore:

®  You can restore only the system that you have previously backed up. HP recommends that you use
HP Recovery Manager to create either a set of recovery discs or a recovery flash drive as soon as
you set up the computer.

®  Windows has its own built-in repair features, such as System Restore. If you have not already tried
these features, try them before using Recovery Manager.

®  Recovery Manager restores only software that was preinstalled at the factory. Software not
provided with this computer must be downloaded from the manufacturer's Web site or reinstalled
from the disc provided by the manufacturer.

Restoring using the dedicated recovery partition
(select models only)

When using the dedicated recovery partition, there is an option to back up pictures, music and other
audio, videos and movies, recorded TV shows, documents, spreadsheets and presentations, e-mails,
Internet favorites and settings during this process.

To restore the computer from the recovery partition, follow these steps:
1. Access Recovery Manager in either of the following ways:
e  Select Start > All Programs > Recovery Manager > Recovery Manager.
—or-

®  Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen. Then, press {11 while the “F11
(System Recovery)” message is displayed on the screen.

2. Click System Recovery in the Recovery Manager window.

3. Follow the on-screen instructions.
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Restoring using the restore media
1. If possible, back up all personal files.

2. Insert the first recovery disc into the optical drive on your computer or an optional external
optical drive, and then restart the computer.

—or —

Insert the recovery flash drive into a USB port on your computer, and then restart the computer.

E’/fNOTE: It the computer does not automatically restart in the Recovery Manager, the computer
boot order needs to be changed.

3. Press {9 at system bootup.
4. Select the optical drive or the flash drive.

5. Follow the on-screen instructions.

Changing the computer boot order

To change the boot order for recovery discs:

1. Restart the computer.

2. Press esc while the computer is restarting, and then press {9 for boot options.
3. Select Internal CD/DVD ROM Drive from the boot options window.

To change the boot order for recovery flash drive:

1. Insert the flash drive into a USB port.

Restart the computer.

Press esc while the computer is restarting, and then press {9 for boot options.

Ll S

Select the flash drive from the boot options window.
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Backing up and recovering your information

It is very important to back up your files and keep any new software in a safe place. As you add new
software and data files, continue to create backups on a regular basis.

How completely you are able to recover your system depends on how recent your backup is.

E‘jNOTE: A recovery from your most recent backup needs to be performed if the computer has a virus
attack or if any major system components fail. In order to correct computer issues, a recovery should
first be attempted before a system restore is attempted. You can back up your information to an
optional external hard drive, a network drive, or discs.

Back up your system at the following times:

e  Atregularly scheduled times

-<?- TIP: Set reminders to back up your information periodically.

e  Before the computer is repaired or restored
e  Before you add or modify hardware or software
Guidelines:

e  Create system restore points using the Windows System Restore feature, and periodically copy
them to an optical disc or an external hard drive. For more information on using system restore
points, refer to Using Windows system restore points.

®  Store personal files in the Documents library and back up this folder periodically.

®  Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your
settings. The screen shot can be a time-saver if you have to re-enter your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste. The screen image is added to
the document.

4. Save and print the document.
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Using Windows Backup and Restore

Guidelines:
®  Be sure that the computer is connected to AC power before you start the backup process.

e Allow enough time to complete the backup process. Depending on file sizes, it may take over an
hour.

To create a backup:
1. Select Start > Control Panel > System and Security > Backup and Restore.

2. Follow the on-screen instructions to schedule and create a backup.

@NOTE: Windows includes the User Account Control feature to improve the security of the computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information.

Using Windows system restore points

A system restore point allows you to save and name a snapshot of your hard drive at a specific point in
time. You can then recover back to that point if you want to reverse subsequent changes.

@NOTE: Recovering to an earlier restore point does not affect data files saved or e-mails created since
the last restore point.

You also can create additional restore points to provide increased protection for your files and settings.

When to create restore points
e  Before you add or modify software or hardware

e  Periodically, whenever the computer is functioning optimally

@NOTE: If you revert to a restore point and then change your mind, you can reverse the restoration.
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Create a system restore point

1. Select Start > Control Panel > System and Security > System.
In the left pane, click System Protection.

Click the System Protection tab.

P @ N

Follow the on-screen instructions.

Restore to a previous date and time

To revert to a restore point (created at a previous date and time), when the computer was functioning
optimally, follow these steps:

1. Select Start > Control Panel > System and Security > System.
In the left pane, click System Protection.
Click the System Protection tab.

Click System Restore.

L S A

Follow the on-screen instructions.
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8 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries

The following requirements are applicable to all countries and regions:
e  The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ).

e All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

e The power cord sets must have a minimum current capacity of 10 A and a nominal voltage rating
of 125 or 250 V ac, as required by the power system of each country or region.

e  The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions

Country/region

Accredited agency

Applicable note number

Argentina IRAM 1
Australia SAA 1
Austria OVE 1
Belgium CEBEC 1
Brazil ABNT 1
Canada CSA 2
Chile IMQ 1
Denmark DEMKO 1
Finland FIMKO 1
France UTE 1
Germany VDE 1
India ISI 1
Israel Sl 1
ltaly IMQ 1
Japan JIS 3
The Netherlands KEMA 1
New Zealand SANZ 1
Norway NEMKO 1
The People's Republic of China CCC 4
Saudi Arabia SASO 7
Singapore PSB 1
South Africa SABS 1
South Korea KTL 5
Sweden SEMKO 1
Switzerland SEV 1
Taiwan BSMI 6
Thailand TISI 1
The United Kingdom ASTA 1

Requirements for specific countries and regions
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Country/region Accredited agency Applicable note number

The United States uL 2

1.

The flexible cord must be Type HO5VV-F, 3-conductor, 0.75-mm2 conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region
where it will be used.

The flexible cord must be Type SVT/SIT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V ac) configuration. CSA or C-UL mark.

UL file number must be on each element.

The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm? or 1.25-mm? conductor size. The
wall plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V ac) configuration.

The flexible cord must be Type RVV, 3-conductor, 0.75-mm?2 conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the CCC certification mark.

The flexible cord must be Type HO5VV-F 3X0.75-mm? conductor size. KTL logo and individual approval number must be
on each element. Corset approval number and logo must be printed on a flag label.

The flexible cord must be Type HVCTF 3x1.25-mm? conductor size. Power cord set fittings (appliance coupler, cable, and
wall plug) must bear the BSMI certification mark.

For 127 V ac, the flexible cord must be Type SVT or SIT 3 x 18 AWG, with plug NEMA 5-15P (15 A, 125V ac), with UL
and CSA or C-UL marks. For 240 V ac, the flexible cord must be Type HO5VV-F 3x0.75-/1.00-mm?2 conductor size, with
plug BS 1363/A with BSI or ASTA marks.
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9 Recycling

When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not dispose

of the battery in general household waste. Follow the local laws and regulations in your area for
battery disposal.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and

rechargeable batteries. For more information about recycling programs, see the HP Web site at
http://www.hp.com/recycle.
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